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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage 
to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices 
referring only to property damage have no safety alert symbol. These notices shown below are graded according to 
the degree of danger.

DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance 
are required to ensure that the products operate safely and without any problems. The permissible ambient 
conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication may 
be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in this 
publication is reviewed regularly and any necessary corrections are included in subsequent editions.
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GERMANY
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Security information 1
Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, systems, machines, and networks.
In order to protect plants, systems, machines and networks against cyber threats, it is necessary 
to implement – and continuously maintain – a holistic, state-of-the-art industrial security 
concept. Siemens’ products and solutions form one element of such a concept.
Customers are responsible for preventing unauthorized access to their plants, systems, 
machines and networks. These systems, machines and components should only be connected 
to the enterprise network or the Internet if and only to the extent necessary and with appropriate 
security measures (firewalls and/or network segmentation) in place.
You can find more information on protective measures in the area of industrial security by 
visiting:
https://www.siemens.com/industrialsecurity.
Siemens’ products and solutions undergo continuous development to make them more secure. 
Siemens strongly recommends performing product updates as soon as they are available and 
using only the latest product versions. Use of product versions that are no longer supported, and 
failure to apply latest updates may increase customer’s exposure to cyber threats.
To stay informed about product updates, subscribe to the Siemens Industrial Security RSS Feed 
under
https://www.siemens.com/industrialsecurity.
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Preface 2
SIMATIC Management Console

• The PCS 7 SIMATIC Management Console (referred to as Management Console in the rest of 
the documentation) is a software product from the SIMATIC PCS 7 series. 

• The Management Console provides functions for determining inventory data and software 
administration of the PCS 7 plant.
(Example: In the figure given below, Determine inventory data; Components present in the 
plant area marked in green)

• Software administration with a central Management Console is more efficient than using a 
local PCS 7 installation.
(Example: In the figure given below, Run setup x; Components present in the plant area 
marked in gray)

The Management Console software packages are available in the Process Control System; 
SIMATIC PCS 7 software.

Scope of the documentation
This documentation applies to the software package Process Control System; SIMATIC PCS 7 
Management Console V9.1.1.

SIMATIC Management Console (V9.1 SP1)
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Required basic knowledge
• This documentation is intended for personnel working in the fields of commissioning and 

service.
• Basic knowledge of working with computers and Windows operating systems is required for 

using the Management Console.
• Knowledge of operating system administration in the relevant network environment is 

required for setting up permissions.
• Basic knowledge of functions and configurations of SIMATIC PCS 7 is also essential.

Preface
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Options for accessing PCS 7 documentation
The documentation required for PCS 7 includes the following types:
• PCS 7 Readme

The readme file is available in two versions:
– PCS 7 Readme (Offline)

This version is installed by PCS 7 Setup. The file only contains general information and 
links to documents on the Internet.

– PCS 7 Readme (Online)
This is the version which contains all the information about the installation and use of 
PCS 7, in a format that the users are already familiar with. The file is only available on the 
Internet so that we can keep it up to date. 
Note
The information provided in the PCS 7 Readme (Online) on the Internet takes precedence 
over all the other PCS 7 documentation. Refer PCS 7 Online Readme (https://
support.industry.siemens.com/cs/ww/en/view/109801032). 
Please read PCS 7 Readme carefully; it contains important and supplementary 
information for PCS 7. 

• PUD Manager
The "PUD Manager" is an innovative tool to access documentation, comes with PCS 7 
software. Some of the highlights are as follows: 
– Create your own Manual library. 
– Customize the documentation set according to your needs. 
– Efficient search algorithm to access your information.

For more information on PUD Manager, refer Process Control System PCS 7; PUD Manager 
Online Help. 

The PUD Manager can also be accessed using the SIMATIC Manager as shown below: 
SIMATIC Manager > Help > Introduction 
As soon as the user opens the PUD Manager, user can find the documentation stored in 
a hierarchical way:
PCS 7 System Documentation

– PCS 7 - Documentation Vx.x  
– PCS 7 - Operating instructions - OS Process Control Vx.x 
– PCS 7 - Installation Manual - PC configuration Vx.x
– PCS 7 - Configuration Manual - Engineering System Vx.x

Preface
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– PCS 7 - Configuration Manual - Operator Station Vx.x 
However, you can extend and update the scope of available user documentation to your 
needs by downloading the individual zip files provided for the manuals and adding it 
under the "Pendingupdates" folder. 

To integrate or update documents, the user must exit the PUD Manager from the system 
tray, run the PUD application as an administrator and make all the hidden folders visible. 

The downloaded package (Zip file) must be stored in the directory:
ProgramData > Siemens > PUDManager > Public > BaseSnippetsRepository > 
PendingUpdates 

User can download the Zip files from the following link Plant and User Documentation 
Manager for SIMATIC PCS 7 (https://support.industry.siemens.com/cs/ww/en/view/
109748882). 

PCS 7 Product Documentation
Contains information about special hardware and software components. The individual 
documents provide detailed information on the specific component.

Full versions of the documentation are available on the "Technical Documentation SIMATIC 
PCS 7" web pages:
Technical Documentation SIMATIC PCS 7 (https://support.industry.siemens.com/cs/ww/en/view/
109801081)
Additional information can be found under the product overview Process Control System PCS 7; 
PCS 7 - Documentation; Section "Options for accessing the documentation".
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Information for administrators
Users who have only administered Windows operating systems can acquire the necessary PCS 
7 knowledge in the PCS 7 documentation. An introduction to the installation and configuration 
of computers in PCS 7 plants in the SIMATIC can be found here; Process Control System PCS 7; 
PCS 7 ‑ PC‑Configuration documentation.

Note
Updating the software and the "SIMATIC Management Agent" service
The software update using the Management Console cannot be performed for some software 
packages of PCS 7. The following software packages can only be distributed as new installations 
with the SIMATIC Management Console:
• Process Historian
• Information Server
• OpenPCS 7 

(Update of the "SIMATIC Management Agent" service is available only for the versions 
ranging from 8.1 - 9.1.x).

• Web Option for OS 
(Web Client or Web Diagnostic Client: Updating the "SIMATIC Management Agent" service is 
available only for the versions ranging from 8.1 - 9.1.x).

• Safety Matrix
(To upgrade the Safety Matrix of the "SIMATIC Management Agent" service, user must 
uninstall the existing Safety Matrix in the target station, and install the latest version 
available manually).

You can find additional information on this in the following sections:
• Section "Downward compatibility with the agents (Page 79)"
• Section "Update or repair SMAgent (Page 67)"

Supported PCS 7 versions
The following table provides information on the supported versions of PCS 7 for the SIMATIC 
Management Console V9.1.1:

 SMMC version  PCS 7 version
SIMATIC Management Console  V9.1.1 • PCS 7 V8.2.1 

• PCS 7 V9.0.1
• PCS 7 V9.0.2 UpdateCollection03
• PCS 7 V9.0.3
• PCS 7 V9.1
• PCS 7 V9.1.1

Preface
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Changes compared to the previous version
Given below is an overview of the most important changes in the documentation compared to 
the previous version:

Table 2-1 Overview of the most important changes
Version Changes
As of 
V9.1.1

• Critical Windows Defender events
The SIMATIC Management Console comes with an option to configure automated e-mails that will be sent 
out, as and when critical Windows Defender events occur in any of the computers present in the network. The 
feature lets the users choose the outgoing e-mail server, encryption protocol to be used (SSL/TLS), port 
number through which the secured e-mail transmission should take place, sender information and the list of 
recipients. 

• SIMATIC Hardware Compare
Users can download the required XML reference file (encrypted) from the internet, and use it to initiate 
SIMATIC Hardware Compare. 

As of V9.1 • Microsoft software update
The Management Console remotely controls the deployment of Microsoft software updates from WSUS to 
WUA on each target computer using the SIMATIC Management Agent.

• Windows Defender signature version and events
The Management Console displays all the events logged in by the Windows Defender in the Events window. 
Critical events are displayed in the Alarms window as well.  Also, inventory information of Virus protection 
now covers the Signature version of Windows Defender.

• Downward compatibility with the Agents
The Management Console supports communication with agents of versions 9.0 and above. This avoids the 
necessity to perform an update of all agents before an updated Management Console can be used with 
already installed PCS 7 computers of an older version. 

• Software integrity check for PCS 7
The Management Console verifies the integrity of the software to be installed as part of the remote software 
deployment. 

• Supported Operating system
The Management Console V9.1 supports the following operating systems:
Windows 10 Enterprise 2019 LTSC
Windows Server 2019 Standard edition 64 bit
Windows Server 2019 Data Center edition 64 bit (SIVaaS only)

• SIMATIC Hardware Compare
The Management Console can compare the versions of the installed hardware and the corresponding firm‐
ware with the latest versions available, and generate a detailed MS Excel report that displays the difference 
in the versions. 

Preface
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Version Changes
As of V9.0 
SP1

• Web server Settings
The Management Console can install or update software on a target computer on which web server is in 
runtime. 

• Plant Inventory online data
The inventory details determined from device data is displayed in a separate column as online data under 
"Inventory" tab in the Plant view. 

• Export inventory details
The inventory details of plant and network objects are exported automatically.
The folder location to save the exported inventory details can also be configured in the "Inventory Data Export" 
tab in the "Settings" dialog.

• SIMATIC Software compare  
The Management Console can now compare the versions of installed software with the latest version of 
software. The Comparison of SIMATIC software excel sheet displays the difference in the version and the 
product links to download the respective software.

• Project inventory data export in iBase format
The Inventory data exported for a project is generated in iBase format.

As of V9.0 
Update 2

•  The online inventory details can be determined for field devices also.

As of V9.0 
Update 1

•  The inventory data for I/O modules now includes information about the slot position of the module in the 
rack.

Preface
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Version Changes
As of V9.0 • Inventory data for ET200SP HA devices

The SIMATIC Management Console gathers additional inventory data for ET200SP HA devices that is available 
through PROFINET. This includes device information that is not configured or visible in PCS 7 hardware 
engineering (HW Config). Other devices connected to a PCS 7 system through PROFINET provide additional 
hardware information which the SIMATIC Management Console is able to display as part of the plant hier‐
archy and inventory reports.

• Include manually entered inventory data for external components in inventory report.
• The inventory provides the build number of the installed Windows version. This is due to a change in MS 

upgrade philosophy starting from Windows 10. Feature updates (former patches) will no longer be reflected 
in versions but only shown as a difference in the build number.

•   Additional to the tape the following data on the hard disk will be displayed:
– Manufacturer
– Name 
– Form factor
– Capacity 
– Driver version
– Driver date

• The details of the installed third-party software will be extended with:
– SQL server
– Installed version of Microsoft .NET Framework with version number
– Microsoft patches with Product name, Publisher, Title, KB and installation date.
– Installed security software with manufacturer, product, version (Symantec Endpoint Protection, McAfee 

Agent, McAfee Endpoint Protection Suite, Trend Micro OfficeScan Corporate Edition V11.0).
• The inventory report has been extended to include the following information:

– Number of Process Objects used in the ES project. This information will be available as part of a new entry 
"Project" under the ES in the Plant View.

• The  SIMATIC Management Console can also be started without a license. In this case all the computers can 
only be assigned to a single group called "Non-licensed computers". The only functions available in this group 
are Determine Inventory Data, Export Inventory Data and Update SMAgent.

• In case SMAgent licenses on the SIMATIC Management Console are not sufficient to assign further computers 
to user defined groups, computers can still be assigned to the "Non-licensed computers".

• Export maintenance data to an XML file using "Project inventory data export..." feature.
• System ID (SID) included in the inventory data.
• The availability of a target computer is not checked for database functions like "Project inventory data ex‐

port..." or "Apply Inventory Data Profile" in case data for the target computer is available in the database.  
• The alarm message system is improved as follows:

– Dedicated message texts differentiate between online and offline determination of inventory data (plant 
view).

Preface
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Version Changes
As of V8.2 • Structure of the plant

– In a Windows domain, the best security level is possible through Kerberos authentication of the frames 
between the Management Console and computers with installed SIMATIC Management Agent.

– The frames to establish a connection between the Management Console and managed computers with 
installed SIMATIC Management Agent are protected by a Pre-Shared Key (PSK = shared network key). 

• Conditions for installation and application of the Management Console
The installation and application of the Management Console is released when the following requirements are 
met on the computers with installed SIMATIC Management Agent (Management Console and managed 
computers):
– The operating system has been approved for this PCS 7 version. You can find additional information on this 

in the Process Control System PCS 7; PCS 7 Readme documentation. 
– PCS 7 Version at least PCS 7 V8.0 and higher with the latest released service pack 

• Installation of software PCS 7 V8.0 and higher with the latest released service pack
The following software has been released for installation with the Management Console software: 
PCS 7 V8.0 and higher with the latest released service pack.
The functionality of the Management Console cannot be used on computers that are operated with Windows 
XP or Windows Server 2003.

• Rights management
The Management Console supports the addition of (domain) user groups in the local user groups.

• Setup packages
The content of the setup packages is apparent.

• You can find a list of all products and PCS 7 components that can be installed using the Management Console 
in the Industry Online Support under entry ID 107796665: Internet link (http://
support.industry.siemens.com/cs/ww/en/view/107796665)

As of V8.1 • The operating states on the PC stations are determined and displayed for the following PCS 7 products before 
the installation of software packages: Operator Station (PCS 7 OS); SIMATIC BATCH; SIMATIC Route Control

• Inventory data profiles allow the comparison of actual device configurations with the target device configu‐
rations

• Ongoing installation procedures are displayed in a list, if the installation procedures were started using the 
Management Console.

• Installation report for PCS 7 plants with installed PCS 7 version as of the DVD PCS 7 V8.0 SP2.
Requirement: The installation procedures were started using this Management Console.

Preface
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Basics 3
3.1 Functions of the Management Console

Basic functions of the Management Console
The following functions are available without configuration of the Management Console:
• Displaying computers of a network

In a PCS 7 plant, the Management Console can establish a connection to the computers on 
which the "SIMATIC Management Agent" service is installed. For additional information refer 
"Installing the Management Console (Page 28)".

• Assigning computers to the Management Console
• Defining groups containing the computers to be managed
• Displaying and exporting alarms
• Displaying and exporting event logs
The following functions of the Management Console require configuration or user selections:
• "Functions for software administration (Page 20)"

These functions support administrative tasks in PCS 7 plants.
• "Functions for determining inventory data (Page 21)"

These functions gather information on objects in PCS 7 plants.

Remote service and remote operation

Note
SIMATIC Management Console and the other computers present in the network can be remotely 
accessed only to initiate and authenticate the installation of Management Agents in the 
respective computers. Any other remote operation of the SIMATIC Management Console is not 
supported.

SIMATIC Management Console (V9.1 SP1)
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3.2 Description of the functions

3.2.1 Functions for software administration
The SIMATIC Management Console has the following functions for central administration of 
software on assigned computers. 
• The installed SIMATIC software of a computer can be determined on the SIMATIC 

Management Console. For additional information refer "Installing SIMATIC software 
(Page 85)".

• The SIMATIC Management Console uses the functions of the relevant product setup for the 
installation of SIMATIC software packages. The following installation variants are possible:
– Installing software packages
– Updating software packages

Note
Installing and updating the Process Control System; SIMATIC PCS 7 software package
• Note the following in the section "Preface; Table 2-1 Overview of the most important 

changes (Page 14)".
• The SIMATIC Management Console cannot be used to install or update SIMATIC softwares 

in the computer(s) in which it is currently installed. For instance, the Engineering station 
software has to be manually installed and updated using the Engineering station 
software setup in the SIMATIC Management Console computer.

• Microsoft software updates can be installed in all the SIMATIC Management Agent 
computers using the SIMATIC Management Console.
For additional information refer Installing and updating software-Overview (Page 80).

Confirming license terms and safety instructions 

NOTICE
License terms and security instructions 
If the license terms and security instructions are accepted when the setup files are created, the 
terms and instructions must also be provided to all other persons who are also authorized to 
install setup packages.
Recommendation:
Copy the contents to a file and notify the authorized persons of the contents.

Example
The following steps are required for the installation of SIMATIC software when using the 
Management Console.

Basics
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Example for the installation of OS clients in PCS 7 plants:
• Optional step: Create the "OS client" group

For additional information refer "Assigning computers (Page 62)".
• Save the software in the network (for example, on a local drive or a file server).

Permission for this storage location must be set up for the users of the Management Console.
Additional information on this is available in the section "Managing rights (Page 25)".

• Setup management
Adding software packages using setup management in the Management Console
Additional information can be found in section "Setup management... (Page 145)".
Optional step: Configure setup packages.
Save the required settings for a specific setup (for example, OS client). This configuration can 
be performed repeatedly without the setup dialog having to be run again. 
For additional information refer "Setup packages (Page 83)".

• Select computers (or "OS client" group only) and run installation.
For additional information refer "Installing SIMATIC software (Page 85)".

Executing setup
• The Management Console installs the software packages on assigned computers.
• The Management Console enables the simultaneous installation of SIMATIC software on 

several computers.
Note
Process mode
Before installing the software on operator control and monitoring stations, we recommend 
that the user performs the following steps:
• Exit process mode
• Close the projects
If the user does not exit the process mode manually, the system will automatically exit the 
process mode and close the projects before the software installation begins.

Additional information
• Section "Installing the Management Console (Page 28)"
• Section "Managing rights (Page 25)"

3.2.2 Functions for determining inventory data
The Management Console provides functions for determining inventory data of objects in a 
PCS 7 plant.

Basics
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Note
Determine inventory data
The computers of the plant must be at least of the version PCS 7 V8.0.
Note the following in the section "Preface; Table 2-1 Overview of the most important changes 
(Page 14)".

Objects
Inventory data can come from both objects in the plant (online data) and objects in project data 
(offline data). Inventory data can be acquired for the following PCS 7 plant objects:
• Computer
• Network components (Ethernet switches)
• Automation system components
• Remote I/Os (including the I/O modules)
• Field devices

Inventory data
Inventory data can include the following information:
• Plant designation (depending on the designation system, e.g., HID / TAG)
• Geographical location (depending on the designation system, e.g., LID)
• Description (user-defined)
• Message (user-defined)
• Device name
• Device type
• Serial number
• Article number (e.g. Siemens: MLFB; order number)
• Hardware version
• Operating system version
• Firmware version
• Windows Defender Signature version
• Installed SIMATIC software
• License information (license keys for SIMATIC software)
• Third-party software installed with PCS 7 software media.

Basics
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Additional information
• Section ""Inventory data" tab (Page 52)"
• Section "Determining inventory data in the network view (Page 101)"
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Installation of the Management Console 4
4.1 Managing rights

You must set up permissions in order to use the Management Console.

User groups and users 
The required user groups are created by the installation of the software. Assign the users to the 
user groups in line with their roles.
• SIMATIC Management Administrators

Members of this group have unrestricted access to and all permissions for the Management 
Console.
Enter the members of this group in the "Administrators" Windows group on the target 
computers. This gives the members of this group permission to make changes to the installed 
software.

• SIMATIC Management Users 
Members of this group are given restricted access to and "Read only" permission for the 
Management Console.
Include users that have been assigned to the "SIMATIC Management Administrators" user 
group on the Management Console computer in the "SIMATIC Management Users" user 
group as well.

• Windows logon to the Management Console computer:
To install the software using the Management Console, the user must log in to the operating 
system with the login credentials. User with Administration rights need not login to 
windows. Instead, the user can login directly to the management console.

Note
Changing Windows user management
• Computer has to be restarted if changes were made to the local Windows groups in the 

Windows user management while operating the Management Console.  
• Always make changes to the user groups for the target system computers as well. Changes 

to the local Windows groups take effect once the program is restarted.
• The target system computer has to be restarted if changes were made on the target systems 

in the "SIMATIC Management Users" group in Windows user management.  
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Assigning users to user groups
Enter users in the following user groups:
• On all computers in the plant: 

Include all users in the "SIMATIC Management Users" group.
• On all target computers: 

All members of the SIMATIC Management Administrators group on the Management 
Console who are to install software should be included in the (Windows) administrator 
group.

• On the Management Console computer only: 
All users of the Management Console must be members of the following groups:
– "(Windows) Administrators" group
– "SIMATIC Management Administrators" group
– "SIMATIC Management Users" group

Add the users to the necessary user groups. The membership in a user group depends on the 
functions which the user is to execute.

Function to be executed
 

Required membership in the user group
 
Required Membership on 
Management Console

Required Membership in a 
Target Computer

• Installing SIMATIC software
• Updating the "SIMATIC Management 

Agent" on the target computer (re‐
mote computer)

• Determining inventory data (plant 
view1))

• Installing Microsoft software up‐
dates

• Updating SIMATIC software

• (Windows) administra‐
tors

• SIMATIC Management 
Administrators

 
 

• (Windows) administra‐
tors

• SIMATIC Management 
Users

• Disable console assignment
• Adapting setup management
• Event display: Deleting events

• SIMATIC Management 
Users.

• Determining inventory data (net‐
work view)

• Exporting inventory data
• Creating, changing, applying inven‐

tory data profile
• Creating installation reports
• Creating installation reports for Mi‐

crosoft software updates
• Create license report
• Exporting reports

• SIMATIC Management 
Users

1) See note "Determining inventory data in the plant view"
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Note
SQL database can only be accessed by a Windows user logged in on the SIMATIC Management 
Console computer. Also, the user must be a part of the SMMC Management Administrators and/
or SMMC Management Users group to be able to access the database.

Note
Determining inventory data in the plant view
Requirements on the engineering station and Maintenance Station:
• A member of the "SIMATIC Management Users" group must be logged onto the 

engineering station.
This user must be a member of the "SIMATIC NET" group on the engineering station.

• If inventory data of switches is to be determined online, the following conditions must also 
be fulfilled:
– The switches are configured on a Maintenance Station. 
– The user logged onto the engineering station is a member of the "SIMATIC NET" group on 

the Maintenance Station.

Setting up permissions for Management Console users
For the installation of software packages, permissions for the users of the Management Console 
are to be set up. Set up the permissions for the locations where software packages are stored. 
These locations include the following:
• Local drives
• Folders on the computer
• Folders in the network
• External drives
Specify the settings on the relevant computer (e.g. file server, management computer, target 
computer).

Note
Setting up permissions for users
Ensure that permissions are set up for the following users:
• Users of the Management Console 
• The "SIMATIC Management Users" group on the target computer

Installation of the Management Console
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Note
Recommendation for increased plant safety
The SMB signature is a function of the operating system. With SMB, communication can be 
signed at the level of the package.
• To increase the security of your plant, "SMB-2 Signing" can be activated. 
• Apply this setting according to the specifications of the operating system manufacturer.
Inadequate protection of the SIMATIC Management Console installation can have the result that 
the SIMATIC Management Console installation and thus the managed documents could be 
manipulated.
• Make sure that the user logged on to the local computer in Windows does not have 

administrator rights.
• Make sure that only the administrator and no other users have write permission for the 

directory in which SIMATIC Management Console is installed. 

Application-specific permissions for software 
Application-specific permissions for groups and users should always be set up for all computers 
using Windows media (administration of workgroups or domains).

Additional information
For additional information on permissions and creating users in the online help of the operating 
system,  use keyword "Help and support".

4.2 Installing the Management Console

Management Console in the network   
• Always choose to set up one Management Console in a network. As presence of several 

Management Consoles in a network can lead to inconsistencies.
• If possible, install the Management Console on a computer that is not required for operator 

control and monitoring purposes. Recommended computers are:
– Separate PC
– Engineering station

• The Management Console should not be installed on the following computers:
– Computers with server functions (e.g. servers or single-station systems for OS, BATCH, 

Route Control, Domain Controller)
– Computers for acquiring archive data (e.g. Process Historian)

Installation of the Management Console
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Requirements
The following requirements must be met before using the Management Console:
• Operating system

The operating system installed on the computers has been released for SIMATIC PCS 7. For 
additional information refer : "www.siemens.com/pcs7-documentation (http://
www.siemens.com/pcs7-documentation)".

• Permission 
The user must have administrator rights to install the Management Console.

• Software  
The software to be installed is available from one shared storage location (shared network 
path, for example \\<Computer name>\<Shared name>). More information can be found on 
the naming conventions and path information in the PCS 7 Readme - Online documentation.

Preparation for the use of the Management Console
Install the necessary software as described below:
• On the Management Console computer
• On all computers to be managed (Agent computers)

Information on this is available in the section "Installing SIMATIC Management Agent 
(Page 31)".

On the Management Console computer 
The Management Console computer is the computer from which administrative tasks are to be 
executed.
Install the software package "SIMATIC Management Console" on the Management Console 
computer using the PCS 7 setup via "Package installation". The "SIMATIC Management Agent" 
software is automatically installed as well.

Note
We highly recommend using "Package installation" over "User-defined installation" as the 
installation type while installing the "SIMATIC Management Console" software package on the 
Management Console computer.
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Updating the Management Console
Please note the following points when updating the software on plant computers:
• Backing up Management Console data. Management Console's configuration with backed 

up data can be restored. 
For additional information refer  "Back up data... (Page 131)".

• On the Management Console computers:
Update the software by installing a later version of the "SIMATIC Management Console". The 
following data is retained:
– Configuration data
– Project data
– Information of the "Event display"

• On all computers to be managed:
Update the "SIMATIC Management Agent" service by means of the Management Console 
network view.
Information on this is available in the section "Update or repair SMAgent (Page 67)"

• From PCS 7 V9.0, a new group named "Non-licensed computers" is added automatically to 
the network view. If a group exists with the same name, then the user is asked to rename the 
group.
Note
To update the SQL server please refer- 
Update the SQL Server with SIMATIC Process Historian/ Information Server (https://
support.industry.siemens.com/cs/ww/en/view/109748200)

Additional information
• Section "Starting the Management Console (Page 39)"
• Section "Managing rights (Page 25)"
• Section "Relocate the Management Console in the network (Page 37)"
• Section "Communication using different subnets (Page 34)"
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4.3 Installing SIMATIC Management Agent

Requirements
The following requirements must be met before using the Management Console:
• Operating system     

The operating system installed on the computers has been released for SIMATIC PCS 7. 
For additional information refer - Process Control System; SIMATIC PCS 7 Readme (online)

• Permission     
The user must have administrator rights to install the Management Console.

• Software  
The software to be installed is available at a shared storage location (shared network path). 
For additional information refer - Process Control System; SIMATIC PCS 7 Readme (online)

On all computers to be managed in the network (Agent computers)   

Note
Domain controller
The "SIMATIC Management Agent" service should not be installed on a domain controller.

You must install the "SIMATIC Management Agent" service on computers to be managed before 
you can use the Management Console. You have the following installation options:
• Installation using the PCS 7 setup

Requirements: The operating system has been approved for this PCS 7 version of the setup.
• Installation from a data media.
The software package required for installation of the "SIMATIC Management Agent" is available 
in the following directory: …\PCS7_Vxx\Additional_Products\SMA__Vx.x 
1. To install the "SIMATIC Management Agent" service, run the setup.exe  file.
2. Follow the instructions in the subsequent dialogs.

Note
Starting the "SIMATIC Management Agent" service
• If the "SIMATIC Management Agent" service was not explicitly selected in the PCS 7 setup, 

start the service on the respective computer for access.
• If the "SIMATIC Management Agent" service was explicitly selected in the PCS 7 setup or re-

installed separately, the service is activated on the respective computer.
• The status of the service does not change if the "SIMATIC Management Agent" service was 

updated at a later time.
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Starting/Stopping the "SIMATIC Management Agent" service 
1. Right click "Start Task Manager" on the affected computer.
2. Click "Services..." in the "Services" tab.

The "Services" dialog box opens.
3. Select the "SIMATIC Management Agent" entry in the "Name" column in the "Standard" tab.
4. Select the shortcut menu command "Properties".

The "SIMATIC Management Agent Properties" dialog box opens.
5. Select the "Startup type" in the drop-down list.

Options:
– Automatic (Delayed Start)
– Disabled

6. Click "Apply".
7. Select the "Service status" to start or stop the "SIMATIC Management Agent".
8. Click "OK".

Uninstallation of the SIMATIC Management Agent
The SIMATIC Management Agent can be uninstalled through the following methods:
• Control panel
Uninstallation of the SIMATIC Management Agent through control panel
1. Open "Control Panel"(Start > Control Panel). 
2. Select "Uninstall a program" (Programs > Programs and Features). 
3. On the "Uninstall or change a program" dialog, select SIMATIC Management Agent from the 

installed program list. 
4. Click "Uninstall". 
The SIMATIC Management Agent is successfully uninstalled.

Installation of the "SIMATIC Management Agent" via a remote desktop connection   
For additional information refer- "Installing the SIMATIC Management Agent over remote 
desktop connection (Page 32)".

4.4 Installing the SIMATIC Management Agent over remote desktop 
connection

Remote access to the SIMATIC Management Console is generally not approved.
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Preparing to install the "SIMATIC Management Agent" service
Prepare for the installation as described in section "Installing the Management Console 
(Page 28)".

Note
Remote installation
Remote installation of the "SIMATIC Management Agent" service is only permitted if process 
mode is disabled on the computers on which the service is to be installed.

The software for the installation of the "SIMATIC Management Agent" service is available from 
one shared storage location (shared network path, for example, \\<Computer name>\<Shared 
name>). 

Procedure   
The following steps can be carried out as an alternative to local installation of the "SIMATIC 
Management Agent" service.
1. Set up release for the path at which the software for the installation of the "SIMATIC 

Management Agent" service is to be run.
2. Open "mstsc" using the search box in the start menu.

The "remote desktop connection" is opened.
3. In the "Computer" input box, enter the computer name or the TCP/IP address of a target 

computer on which the "SIMATIC Management Agent" is to be installed.
4. Click "Connect".

The remote desktop connection opens.
5. In the "User name" input box, enter the name of the administrator who has administrator 

rights on the target computer.
6. Enter the password of the administrator in the "Password" input box.
7. Click "OK".

And  start working remotely on the target computer in the network.
8. Open Windows Explorer.
9. In the command line, enter in UNC notation the share path on which the software package 

is located (\\<Computer name>\<Share name>).
10.Navigate to the setup for the "SIMATIC Management Agent":

…\PCS7_Vxx\Additional_Products\SMA__Vx.x 
For example:
\\<Computer name>\<Share name>\PCS7_Vxx\Additional_Products\SMA__Vx.x

11.Run setup.
The "SIMATIC Management Agent" software package is installed.

12.Close the remote desktop connection.
13.Repeat steps 4 to 13 for all other target computers.
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4.5 Communication using different subnets
Observe the following information if there is a firewall between the following computers:
• SIMATIC Management Console computer 
• Target computer (computer with installed SIMATIC Management Agent) 

Communication in the same subnet
If the SIMATIC Management Console computer and the target computers with installed SIMATIC 
Management Agent are in the same subnet, the PCS 7 Security Controller automatically makes 
the adjustments required for the local Windows firewall:
• On the SIMATIC Management Console computer during installation of the SIMATIC 

Management Console.
• On the target computer during installation of the "SIMATIC Management Agent" service.

Communication using different subnets

Note
Network type: Domain or workgroup
The type of network in which the SIMATIC Management Consoles - computers and the 
computers with installed SIMATIC Management Agent - are located must always be the same.  

If the computers are located in different subnets, the communication settings of the local 
Windows firewall and any existing external firewall are to be adjusted, if installed.
Configuration of the local Windows firewall
As standard, the local Windows firewall of a computer only enables the local subnet as 
authorized area. 
Change the "SIMATIC Management Agent" (SMAgent_32.exe) service for the computers in the 
local firewall:
1. Open the settings of the Windows firewall.
2. Select the advanced settings.
3. Select "Inbound Rules" in the tree structure. 
4. Select the "SIMATIC Management Agent" program and open the properties from the shortcut 

menu.
5. Open the "Scope" tab.
6. In the "Remote IP Address" area, enable the setting "These IP addresses".
7. Enter the required subnet areas or fixed IP addresses.
Configuration of the external firewall
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Make the following changes if both these statements apply:
• The computers are located in different subnets.
• The communication between the SIMATIC Management Console computer and the target 

computer with installed SIMATIC Management Agent is protected by an external firewall.
When using an external firewall, add exceptions for the subnets in the settings of this firewall. 
Add the following TCP and UDP ports:
• 7911
• 7912

If an external firewall or router which is used closes inactive connections then, ensure that 
the update cycle time in SMMC is less than the timeout of the device to close inactive 
connections.
Note
Automatic detection of computers is limited to the particular subnet in order to limit the 
network load. Therefore, the computers that are not a part of the subnet must be manually 
assigned to the SIMATIC Management Console by right-clicking on "Network" and choosing 
the "Add computer" option.

Additional information
For additional information on the documentation Process Control System PCS 7; PCS 7 - PC 
Configuration.
• Access to PC stations outside a subnet
• Using encrypted communication 

4.6 Licensing
The SIMATIC Management Console is a product of PCS 7 that requires a license. SIMATIC 
software checks the license for software use based on license keys. These license keys are the 
technical representatives of the license.

License keys for use of the Management Console
The unrestricted use of the complete SMMC functionality requires the following licenses:

License Key No of Licenses Remark
Management Console Per Management Console Version specific license.
SIMATIC Management Agent 1 per managed computer Version independent.

Using Management Console without SMMC License
During SIMATIC Management Console startup, the user is prompted to accept all previously 
assigned computers (if applicable) to be moved to "Non-licensed computers" group or to cancel 
the start of SIMATIC Management Console in order to install the required license.
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Using Management Console with insufficient SMA Licenses
• The number of installed SMA licenses is lower than the number of computers assigned to 

user defined groups.
• During SIMATIC Management Console startup, the user is prompted to select assigned 

computers (if applicable) to be moved to "Non-licensed computers" group or to cancel the 
start of SIMATIC Management Console.

Using Management Console with Non-licensed computers
Computers in "Non-licensed computers" group can be specified as Engineering Station in order 
to select a project for inventory.
Under the "Non-licensed computers" node, the functions available for the computers are as 
follows:

Network View Plant View
Determine Inventory Data, Export Inventory Data, 
and Update SMA agent

Determine Inventory Data, Export Inventory Data, 
Project Inventory Data Export.

Using Management Console with PCS 7 Trial License
With the installation of the Management Console, a license key for the demo mode is 
automatically available. 
• Duration: 14 days
• The size of the plant is limited to 10 Agent computers.

Additional information
• Information on the number of used license keys is available in the section ""License keys" tab 

(Page 52)".
• For additional information on licenses and license-dependent quantity structures of PCS 7 in 

the documentation Process Control System PCS 7; Licenses and Quantity Structures.
• For additional information on the provision of license keys in the plant in the 

documentation SIMATIC; Automation License Manager. 
• Information on licensing models can be requested from Siemens contact person.
• When the SMA license key is not sufficient for all the assigned computers, a dialog is 

displayed, where computers can be deselected to move from the network to the "Non-
licensed computers" folder.

• When SIMATIC Management Console license is not available or the trial license is no longer 
valid, a dialog is displayed, where SIMATIC Management console can be opened with all the 
assigned computers in the "Non-licensed computers" folder or cancel the opening process 
from SIMATIC Management Console.
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4.7 Relocate the Management Console in the network

Activate a new Management Console in the network

Note
Only one Management Console is permitted in the network
In a network, try to install only one Management Console. That way, computers that are to be 
managed only report the information to a single Management Console computer. 
Back up of the Management Console data can be saved in the database, and can be restored 
whenever required.

To activate the Management Console on another computer (Referred as "Console2"), the 
following scenarios apply:
• Computer "CONSOLE1" is available in the network:

– Back up the Management Console data from "CONSOLE1" computer.
Refer section "Back up data... (Page 131)".

– Cancel the console assignment between the managed computers and "CONSOLE1" so 
that "CONSOLE2" can take over. 
Refer section "Disable console assignment (Page 133)".

– Uninstall the Management Console on the computer "CONSOLE1".  
• "CONSOLE1" computer is not available in the network, computer "CONSOLE2" is 

operational.
Select between either of the following actions:
– Use the function "Recover database" on the computer "CONSOLE2" to back up the data of 

the Management Console of computer "CONSOLE1".
– Reconfigure the Management Console data.

4.8 Removing the Management Console
Depending on the purpose, different software packages are installed on the computers for using 
the Management Console functions.
• The following software packages are installed on a computer with Management Console:

– The Management Console
– The "SIMATIC Management Agent"

• Only "SIMATIC Management Agent" is installed on a computer without Management 
Console.
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Uninstall the following while executing the removal through the "Programs and Functions" 
software management:
• SIMATIC Management Console 
• SIMATIC Management Agent

Note
• Uninstalling the SIMATIC Management Agent is only possible through MS Windows 

functions, which are available in the SEBU_SMA installation software(PCS 7 additional 
products.)

• Uninstalling the software is necessary to convert the Management Console computer into a 
managed computer.

• To convert the Management Console into a managed computer (Agent computer), the actual 
Management Console is to be uninstalled using "Programs and features". Which will stop the 
SIMATIC Management Agent services temporarily. The SIMATIC Management Agent services 
are to be manually restarted through services.msc in the Agent computer, so that it can be 
assigned to the new Management Console.
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Operator control 5
5.1 Starting the Management Console

SIMATIC Management Console can be found in the Windows Start menu.
Use the search box in the start menu to open: SIMATIC Management Console.

Remote service and remote operation
Users can neither operate nor execute functions of the Management Console over a remote 
connection.

Logon
Authenticate with "user name" and "password" before working with the Management Console. 
Enter the pre-shared key for the first application of the Management Console. 
The pre-shared key should be changed at regular intervals. To do this, select the menu command 
Options > Set pre-shared key... .
For additional information refer "Connecting (Page 71)". 

Note
• The user must be a member of the local "SIMATIC Management Users" group.
• While logging in, always use the credentials assosciated with the environment in which the 

Management Console is installed. In most cases, the environment would be "Domain". So, 
the computer would be connected to the domain, and identification methods of domain will 
be used to authenticate the account. In that case, use a Windows credential that is a member 
of the domain to log into the application. 

• If in case, the environment of the computer in which the Management Console is installed 
has to be switched from Workgroup to Domain or vice-versa- 
– Make sure to manually add all the users associated with the Management Console to the 

"SIMATIC Management Users" and "SIMATIC Administrators" group for that particular 
environment.
If not, the users won't be able to access the SIMATIC Management Console database and 
therefore can't log in.

– Once done, restart the machine for the privileges to take effect.

Switching language in menus and dialog boxes 
Select the menu command Options > Language... .

Assigning computers with the Management Console
After starting the SIMATIC Management Console for the first time, assign at least one computer 
to the Management Console:
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To do so, drag a computer from the "Non-assigned computers" folder and drop it into the 
"Network" folder in the network view.

Note
Representation of the computer with the Management Console in network view
• Management Console is active, only when the first computer is connected to the network.
• When at least one computer has been assigned to the Management Console, the computer 

in which the Management Console is installed gets highlighted in bold.
If in case the authentication fails, and a connection could not be established with the 
required computer, check-
• The correctness of the credentials entered.
• If the system clocks of the Management Console and the selected computer are 

synchronized. Make sure that the time difference between the two systems are not more 
than 4 minutes. 

Additional information
• Section "Assigning computers (Page 62)"
• Section "Managing rights (Page 25)"
• Section "Language... (Page 139)"

5.2 Layout of the user interface

Layout of the main window of the Management Console
• Title of the dialog box SIMATIC Management Console - <Name of the local computer>
• Menu bar
• Toolbar
• Project views

(Network view / Plant view)
This area displays a structure with groups and computers 
on the left side of the dialog box.

 

• Details area
This area displays information on the 
object selected in the project view.

• "Messages" area
This area displays messages concern‐
ing actions and objects.

• Status bar
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Display
The plant objects are displayed in the project view on the left side of the Management Console 
dialog box. The width of this area can be changed. Use the tabs to select how the plant objects 
are displayed:
• Network view (Page 44): The network view shows the computers of the network in a tree 

structure defined by the user. 
Select the network view to perform the following with the Management Console:
– Determine the inventory data of computers
– Install software on target computers (remote installation)

• Plant view (Page 49): The plant view shows the objects of the PCS 7 projects in a tree 
structure.
– Select the plant view to use the Management Console to determine the inventory data of 

PCS 7 plants.
The right side of the dialog box contains the details area and "Messages" area.
• In the details area, select which information is to be displayed from the tabs. The information 

displayed depends on the following conditions:
– The object selected in the project view
– The menu command (menu line, toolbar, shortcut menu)

Note
View when you reopen the Management Console
The Management Console always starts in the network view.

Details area and "Messages" area
The following tabs are available following installation of the Management Console:
• Tabs in details area

Network view Plant view
• "Installed SIMATIC software" tab (Page 51)
• "Inventory data" tab (Page 52)
• "License keys" tab (Page 52)
• "Device status" tab (Page 53)

• "Inventory data" tab (Page 52)

• Alarm list (Page 59)
Adjusting areas
• The size of the two areas can be changed in inverse ratio to one another. When one area is 

maximized, the other one is hidden.
• The header indicates which area is shown.

Sorting in tables
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It is possible to sort the content of some tables of the Management Console. 
• When this is possible, a small triangle symbol appears when clicked in the header of the table 

(see "Computer name" column in the "Messages" area of the "Main window").
• To change the sort order, click the header of the column selected for sorting.
Status bar
The status bar includes information on the actions and the current user.
Detailed information is available in the section "Status bar (Page 57)".

Additional information
Section ""Event display" dialog box (Page 60)"

5.2.1 Title bar
The following is displayed in the title bar:
• The product name 
• The name of the computer on which the Management Console is installed.

5.2.2 Menu bar

Layout
Given below is an overview of the Management Console menus.

Menu Submenu 
File • Back up data... (Page 131)

• Restore data... (Page 132)
• Exit (Page 132)

Edit • Create group (Page 133) 
• Delete group (Page 133) 
• Disable console assignment (Page 133) 
• Update network view (Page 134) 

View • Network view (Page 135)
• Plant view (Page 136)
• Event display... (Page 137)
• Running installations... (Page 137)
• SMAgent license display... (Page 138)
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Menu Submenu 
Options • Language... (Page 139) 

• Set pre-shared key... (Page 139)
• Settings... (Page 140) 
• Setup management... (Page 145) 
• Project inventory data export... (Page 148)
• External components... (Page 148)
• Inventory data profile wizard... (Page 149)
• Create license report... (Page 150)

? (Help) • Available plug-ins... (Page 151) 1)

• Help (Page 151) 
• Info... (Page 151) 

1) The plug-ins supplied with the Management Console cannot be installed or removed separately.

5.2.3 Toolbar
The toolbar is located below the menu bar. By clicking on a button, the menu command can be 
invoked without having to open a menu. 

Toolbar

Symbols     
Meaning of the symbols:

Symbols Menu command
Update network view (Page 134) 

Create group (Page 133) 

Delete group (Page 133) 

Inventory data profile wizard... (Page 149)

Apply inventory data profile... (Page 119)

Create installation report... (Page 94)

Determine inventory data
• Determining inventory data in the network view (Page 101)
• Determining inventory data in the plant view (Page 106)
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Symbols Menu command
Exporting inventory data
• Exporting inventory data in the network view (Page 102)
• Exporting inventory data in the plant view (Page 111)
Installing SIMATIC software (Page 85) 

5.2.4 Project view

5.2.4.1 Network view
Select the network view to perform the following with Management Console:
• Determine the inventory data of computers
• Install SIMATIC software on target computers (remote installation)
• Install Microsoft software updates on target computers (remote installation)

Note
Following installation of the Management Console
The following objects are displayed in the network view following installation of the 
Management Console:
• "Network" node
• "Non-licensed Computers" (computer which has no SMAgent license)
• "Non-assigned Computers" group (includes newly discovered computers in the same subnet 

with installed and activated SIMATIC Management Agent service)
• Name of the computer with the local Management Console.

Preparing the network view
To be able to use the functions of the Management Console, add the computers of the network 
to the Management Console. For additional information refer:
• Section "Create group (Page 66)"
• Section "Assigning computers (Page 62)"
• Section "Adding computers (Page 63)"

Objects in the network view
The network view shows the computers of the network in a tree structure defined by the user. 
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The following computers are displayed in the network view when the Management Console 
opens:
• Computers with an activated SIMATIC Management Agent are detected automatically.
• Computers that have already been assigned to the Management Console. The computers are 

shown regardless of their availability.

Object Meaning
Non-assigned computers1) The computer has been recognized by the Management Console. 

Note:
To be able to use the functions of the Management Console, assign the 
computer to the Management Console.

Non-licensed computers The following functions are used in this node:
• SMAgent Update
• Determine inventory data
• Export inventory data

Assigned computers1) The computer has been assigned to the Management Console. 
Options:
• The computer communicates with the Management Console.
• The computer does not communicate with the Management Con‐

sole. Examples of such computers are:
– Computers which are switched off.
– Computers which have been excluded from the analysis for serv‐

icing purposes.
– Different pre-shared key between Management Console and 

computers with installed SIMATIC Management Agent
Additional information is available in the section "How to change 
the pre-shared key on a computer at a later time  (Page 74)".

Groups with computers1) Every user of the Management Console can create groups and move 
computers within the Management Console.

1) See symbols in the network view

Symbols in the network view
An symbol indicates the current status of a computer. For additional information refer  "Symbols 
in the network view (Page 46)".

Updating the view
For an up-to-date display of the computers connected to the Management Console, select the 
menu command Edit > Update network view (F5).
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Information is displayed in the tabs in the details area when clicked on a SIMATIC PC station.

Note
For all other objects, no data is displayed (network nodes, groups, non-assigned or non-
accessible computers).

Additional information
• Section "Starting the Management Console (Page 39)"
• Section "Create group (Page 66)"
• Section "Network view (Page 135)"

5.2.4.2 Symbols in the network view

Table 5-1 Symbols for the type
Icon Meaning

Network folder
Computers located directly in the network folder are assigned to the local Management 
Console.
Group

Computer 

Table 5-2 Symbols for the status of groups
Icon Status Meaning

Plant-specific group This group contains the computers which are assigned to this 
group on the local Management Console.

Non-assigned comput‐
ers

This group contains the computers which are not assigned to the 
local Management Console.

Action "running" Actions have been started for at least one computer in this group. 
At least one action has not yet been completed.

Action "successful" Actions started for the computers in this group have been com‐
pleted successfully.

Action "faulty" Actions have been started for at least one computer in this group. 
At least one error was detected during execution. 
• Open the group folder and check the messages for computers 

with action errors. 
• For additional information, see symbol for '"Action faulty" 

computer'. 
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Table 5-3 Symbols for the status of computers
Icon Status Meaning

Not assigned The computer has been recognized by the Management Console 
or the pre-shared key on the assigned computer differs from the 
pre-shared key of the local Management Console. 
• To be able to use the functions of the Management Console, 

you must assign the computer to the Management Console.
Causes 
Computers are marked with the "Not assigned" symbol in the 
following cases:
• After the user logs on: 

– The computers are not assigned to any Management 
Console. 

– The authentication between the Management Console 
and the target computer has failed.
For additional information refer  "Managing rights 
(Page 25)".

• After updating the view:
– The computers are not assigned to any Management 

Console. 
– The computers are already assigned to another Manage‐

ment Console.
Assigned The computer is assigned to the local Management Console and 

is available.
Check The Computer is being checked.
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Icon Status Meaning
Not available Causes:

• The computer is switched off or rebooting
• The SIMATIC Management Agent service is not active/disa‐

bled in the target computer
Actions to be taken:
• The users can wait or try to reset the status of the target 

computer
• The users can check the status of the SIMATIC Management 

Agent service in the computer and take necessary action
 
Other Causes:
The computer is assigned to the local Management Console but 
is not available.
This may be the case when the target computer and the SIMATIC 
Management Console are a part of the same domain but are in 
different subnets. 
• The Management Console communicates with the target 

computers using the connection details that are stored inter‐
nally during the initial network assignment. So, when the 
connection data of a target computer is modified (Assigned 
with a different IP address or to a different subnet), the SI‐
MATIC Management Console cannot access the target com‐
puter.  

• To update the connection details of a target computer: 
– Remove the target computer from the network
– Update the network view
– Add the computer back to the network 

Action "running" Actions have been started for this computer. At least one action 
has not yet been completed.

Action "successful" Actions started for this computer have been completed success‐
fully.

Action "running" - er‐
ror detected

Actions have been started for this computer. At least one error 
was detected during execution. 
• Check the messages for computers with action errors. 

Action "completed" - 
error detected

All actions are finished for this computer. At least one error was 
detected during execution.
• Check the messages for computers with

action errors.
Version mismatch 
with compatibility

The master Management Agent and the client Management 
Agent are of different versions, yet they are compatible. Man‐
agement Console will be able to communicate with the target 
computer, but only for limited functionalities.

Version mismatch 
without compatibility

The computer is outdated, it must be updated to facilitate com‐
munication between the computer and the Management Con‐
sole. 
Refer  "Updating the SMAgent" for more information.
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Table 5-4 Symbols for readiness of computers for installation
Icon Status Meaning

Status unknown The status of the computer has not been determined yet.

Ready for installation The computer is ready for installation.

Not ready for installa‐
tion

The computer is not ready for installation. 
For additional information refer  "Computer is not ready for in‐
stallation (Page 127)"

5.2.4.3 Plant view
Select the plant view to use the Management Console to determine the inventory data of PCS 7 
plants.

Note
Following installation of the Management Console
The plant view only shows the "Plants" node. 

Preparing the plant view
The following steps must be taken to display information about objects of the PCS 7 plants in the 
plant view:
1. Add the engineering stations to the Management Console.

For additional information refer "Settings... (Page 140)".
2. The PCS 7 projects of the plants are available. 

For additional information refer "Dialog box "Add plant (2/2) - Select projects" (Page 105)".

Plant view objects
When you select an object within a project in the plant view, information on the selected object 
is displayed in the "Inventory data" tab. 

Object (examples) Nested objects (examples)
SIMATIC station (automation sys‐
tem)

CPU
Communications processors
Modules of the central and distributed I/O

Switches Modules
Field devices  
External components Customer components Example: Printer, Displays, Switches.

Symbols in the plant view
A symbol indicates the current status of the objects in the plant view. For additional information 
refer "Symbols in the plant view (Page 50)".
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Updating the view
Determine the inventory data in the plant view again.

Additional information
• Section "Starting the Management Console (Page 39)"
• Section "Plant view (Page 136)"

5.2.4.4 Symbols in the plant view

Table 5-5 Symbols for the type
Icon Meaning

Attachment folder

Multiproject in the plant view

Project in the plant view

Rack
SIMATIC station

SIMATIC H station

I/O module, power supply, CP, CPU, etc. 
Components added in the hardware configuration (e.g. WinCC application, etc.)
Field device

PC station / Automation system

Network switch

External components

5.2.5 Details areas in the network view

5.2.5.1 "Details area" overview in the network view

Information in the details area
The details area displays information on an object selected in the project view. This central area 
shows context-sensitive information.
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Updating the display
The following objects can be updated in the network view:
• Network folder
• Non-licensed computers
• Groups
• Individual computers

Tabs in details area
In the details area, you will see the following tabs:
• "Installed SIMATIC software" tab (Page 51)
• "Inventory data" tab (Page 52)
• "License keys" tab (Page 52)
• "Device status" tab (Page 53)

5.2.5.2 "Installed SIMATIC software" tab
Display of information of a selected computer.
On the "Installed SIMATIC software" tab, software details, software packages and software 
installed on the computer are displayed. 
The software details of the product are displayed at the beginning of the table. Software details 
such as Product Name, Version, Release Version, Technical Version and Installation Date are 
displayed. The software details are displayed in bold. 
Only the name and Installation date of the installed software packages are displayed. This 
information is also displayed in bold. 
The software installed from the software package are also displayed in the table. The installed 
software details such as Version, Release Version, Technical Version, and Installation Date are 
also displayed.

Note
Only the installation date of the software package is displayed and not the version details of the 
software package.
The installation date of the software package is not modified due to the installation of an update 
for the software package. 

The column "Latest version" is displayed on the "Installed SIMATIC software" tab only when the 
software versions are compared through "Compare SIMATIC software versions..." option. This 
column lists the latest version of the installed software and the values in the "Latest version" 
column is displayed only when there is a difference between the installed version and latest 
version of the software.
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If the software version is different from the version specified in the version definition file (XML), 
then the installed software details are displayed in red. If the software version is same as the 
version in the XML file, then the installed software details are displayed in black.  
If SIMATIC software version comparison is applied for a network, group or a computer, the status 
of the computer is displayed as "Comparison of SIMATIC software versions:<applied date and 
time>" at the top of the tab. 
If inventory details are determined for the network, the status is changed to "Inventory 
determined: <date and time>"and the "Latest version" column is not displayed.  
For more information on the SIMATIC software version comparison feature see, Comparing 
SIMATIC software versions  (Page 121).

Procedure
You can find additional information about this in the section "Determining inventory data in the 
network view (Page 101)".

5.2.5.3 "Inventory data" tab
The "Inventory data" tab displays information on an object selected in the project view. In the 
network view, the inventory data of a computer that has been assigned to the Management 
Console are determined. Inventory data of a computer includes extensive details about - 
hardware, software, Operating system and much more.

Procedure
For additional information refer "Inventory data in the network view (Page 101)".

5.2.5.4 "License keys" tab
The license keys found on computers using the "Determine inventory data" function can be 
displayed in this tab.

Note
Detailed information on license keys
Detailed information on license keys can be obtained with the Automation License Manager. 
The "Status" column only shows the following information for the respective license key:
• Installed
• Used
Details of the other columns can be found in the description for the Automation License 
Manager.

Procedure
For additional information refer "Determining inventory data in the network view (Page 101)".
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5.2.5.5 "Device status" tab
The "Device status" tab shows the status information and operating modes of the selected 
computer in the network view.

Requirements
• The computer is connected to the Management Console.
• The network view is opened, and a computer is selected.

Procedure
1. For additional information refer "Determining inventory data in the network view 

(Page 101)".
Note
Update time
The information in the "Device status" tab is updated after the following events:
• After a computer in the network view is selected for the first time (change to another PC 

or back)
• Automatically after expiration of the update time for devices (see paragraph "Setting the 

update") 
Setting the update
• The device status is automatically updated in the SIMATIC Management Console. 
• Specify the cycle time for updating in the menu Options > Settings > "Update device 

status" tab (Page 140).

Result
• Up-to-date information for available computers is shown in the details area.
• The latest status information is displayed for the selected computer in the "Device status" tab.
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Status information
The status information contains computer-specific properties:
• Connection status

Shows the status of the connection to the Management Console:
– Connected
– Physically available
– Not available

• Action
Shows the status of the current action or the last action executed.
Examples:
– SIMATIC software installation running without errors since <date, time> ....
– SIMATIC software installation completed without errors <date, time> ....

• Agent Version
Shows the version of the "SIMATIC Management Agent" service installed on the computer.

• Role
Displays the configurations of the PC stations based on the installed software packages.
Examples:
– OS server
– OS client/engineering station
For additional information refer the Process Control System PCS 7; PCS 7 - PC Configuration 
documentation.

• Operating mode (WinCC)
Displays the determined operating mode of WinCC for the computer. Options: 

Operating mode Information on the product
--- Product is not installed or no project is open.
Active Process mode active
Inactive No process mode
State change Product is installed, the operating mode is currently being 

changed.
Not initialized Product is installed but the role has not yet been initialized.
Unknown Product is installed but the role could not be determined.

• Autostart (WinCC)
Displays the determined AutoStart configuration of WinCC and the activated project for the 
computer. Options: 

AutoStart Information on the project
Active The path and name of the activated project are shown.
Not active AutoStart is not activated.
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• Operating mode (BATCH)
Shows the determined operating mode of SIMATIC BATCH for the computer. Options: 

Operating mode Information on the product
--- Product is not installed or no project is open.
Active Process mode active
Inactive No process mode
State change Product is installed, the operating mode is currently being 

changed.
Inactive, ready to install Product is installed but the role has not yet been initialized.
Unknown Product is installed but the role could not be determined.

• AutoStart (BATCH)
Displays the determined AutoStart configuration of SIMATIC BATCH and the activated project 
for the computer. Options: 

AutoStart Information on the project
Active AutoStart is activated.
--- AutoStart is not activated.

• Operating mode (Route Control)
Displays the determined operating mode of SIMATIC Route Control for the computer. 
Options:

Operating mode Information on the product
--- Product is not installed or no project is open.
Active Process mode active
Inactive No process mode
State change Product is installed, the operating mode is currently being 

changed.
Inactive, ready to install Product is installed but the role has not yet been initialized.
Unknown Product is installed but the role could not be determined.
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• Autostart (Route Control)
Displays the determined AutoStart configuration of SIMATIC Route Control and the activated 
project for the computer. Options: 

AutoStart Information on the project
Active AutoStart is activated.
--- AutoStart is not activated.

• Redundancy status
Displays the determined redundancy status for the computer. Options: 

Redundancy status Information on the redundancy status
Not initialized Product is installed but the role has not yet been initialized.
Master (redundant partner 
<computer name>)

The computer is the master of the redundant computer pair. The 
redundant partner <computer name> is available.

Standby (redundant partner 
<computer name>) 

The computer is ready for operation. The computer can take over 
the tasks of the redundant computer <computer name>.

Error Redundancy faulty. Correct the fault.
--- Redundancy is not available for the role of the computer (e.g. ES is 

not installed/enabled)

5.2.6 Details area in the plant view

5.2.6.1 "Details area" overview in the plant view

Information in the details area
The details area displays information on an object selected in the project view. This central area 
shows context-sensitive information.

Updating the display
In the plant view, information of the object can be updated using the "Determine inventory data" 
shortcut menu. The information is shown only in the "Inventory data" tab.

Tabs in details area
In the details area, following tabs are available:
• "Inventory data" tab (Page 56)

5.2.6.2 "Inventory data" tab
The "Inventory Data" tab displays inventory data of the object (project / multiproject) selected in 
the plant view.
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In the plant view, the inventory data of the object selected in the tree structure is determined.
The determined plant inventory details of the selected component are displayed in this tab. On 
the “Inventory Data” tab, selected object and its configured devices can be viewed in the tree 
view. Also, the inventory details of other plant such as property of the device, value (offline), and 
value (online) are displayed. 
The inventory data determined from configuration data on the engineering machine is displayed 
in the Value (offline) column and the inventory data determined from device is displayed in the 
Value (online) column.
When the configuration data (offline) is determined it overwrites the existing plant inventory 
details and the Management Console displays only the latest value (offline) details. When the 
device data (online) is determined, both Value (offline) and Value (online) details are displayed.

Note
If connection to the Automation system device is not available, then the determined device data 
(online) displays only offline values. 

Procedure
You can find additional information about this in the section "Inventory data in the plant view 
(Page 104)".

5.2.7 Status bar
The status bar is the lowest bar in the dialog box of the Management Console.

Layout
Given below is an overview of the elements in the status bar:

Cell Information Notes
1st cell Information about 

menu functions
When you move the mouse pointer over one of the following 
objects, information about the menu function is displayed:
• Menu commands
• Icons in the toolbar

2nd cell Information on the plant 
view

Currently running action
3rd cell A bar shows the progress of an ongoing action.
4th cell Information on network 

view
(only for "Update net‐
work view")

Information on updating the network view
5th cell A bar shows the progress of the network view update. 

6th cell Logged-on user Shows the Windows user logged on to the Management Console.
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5.2.8 Messages and events

Alarm lists
Information about all the Management Console objects are displayed in lists. 
Default setting: 
New entries are added in the first row and scrolling is automatic. 
The lists are available at the following locations:
• In the details area: "Alarm list (Page 59)"

This information is deleted when the following actions are performed:
– The Management Console is closed.
– The Console GUI language is switched. 
Information for the following objects is only displayed in the "Messages" tab:
– Unavailable PC stations

• In the ""Event display" dialog box (Page 60)"
This information is saved and retained even when the Management Console is closed

Note
While exporting Alarm/Event list to Microsoft Excel, the "Seconds" information is not visible in 
the "Date/Time" column in some cases.
Causes:
Cell property of the column "Date/Time" is set to Custom (hh:mm format). 

Configuring columns
• Sorting a column:

Left-click on the header of the relevant column to sort in ascending or descending order.
• Hiding and showing a column:

– Right-click on the relevant table header
– In the shortcut menu, select which columns are shown and hidden.
– To change the display, click on the corresponding menu entry.
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5.2.8.1 Alarm list

Alarms
Alarm messages for all the objects of the Management Console are displayed. These messages 
are deleted in the following cases:
• The Management Console is closed.
• The user interface language is switched (menu: "Options > Language...).

Entries in the "Alarms" tab
A message consists of the following data:
• Date/time
• Computer name
• Description of the event which has occurred.

Export 
The information displayed in the message list can be exported to a CSV file.
1. Select the shortcut menu command Export...  in the message list.
2. In the "Save as" dialog window, enter the name of the export file and select the path where 

the export file should be stored.
– "Save" button: 

The information is exported.
– "Cancel" button: 

The information is not exported.
The CSV file can be processed further (e.g. in Microsoft Excel).

Delete 
Information displayed in the message list can be deleted.
Select the shortcut menu command Delete all in the message list.

Autoscroll 
New messages are automatically displayed in the message list if the default setting for 
"Autoscroll" in the Management Console is not changed. 
To change this setting, select the shortcut menu command "Autoscroll" in the message list.
• Select the check box on the menu command which means Autoscroll is activated.
• Clear the check box on the menu command which means Autoscroll is deactivated.
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Showing message information
If a message information is not completely displayed in the message list, use the shortcut menu 
command Display message information text to open a window in which the complete 
message is displayed.

5.2.8.2 "Event display" dialog box
The event display logs information on operator actions and changes in the Management 
Console. The event display is shown in a separate dialog box. 

Calling the event display
To do this, select the menu command View > Event display... .
The event display shows information on the following:
• Logons and logouts from the Management Console
• Failed login attempts
• Available computers that are assigned to the Management Console

Note
Display for non-assigned and unavailable computers
• "Computer not accessible" event 

For unavailable computers.
• No event display

For non-assigned computers.

Entries in the event display
An entry consists of the following data:
• User name
• Date/time
• Event (short description)
• Description of the event which has occurred.
• Computer name
• Type: Alarm, warning, information

Log
The following events are logged in the event display:
• Activation of the computer role "SIMATIC Management Console"
• Assign / cancel assignment of computers to the Management Console 
• User logons to the Management Console
• All the events logged by Windows Defender
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• Feedback on installations
– Performed actions/functions
– Faulty actions/functions

• Activation of Demo mode

Note
Critical events logged in by Windows Defender are displayed in the "Alarms" window as well.

Export 
The information shown in the event display can be exported to a CSV file.
1. Click "Export..." in the event display.
2. In the "Save as" dialog window, enter the name of the export file and select the path where 

the export file should be stored.
– "Save" button: 

The information is exported.
– "Cancel" button: 

The information is not exported.
The CSV file can be processed further (e.g. in Microsoft Excel).

Delete
The information shown in the event display can only be deleted by users with administrative 
rights.
• "Delete all" button: 

All entries in the event display are deleted.

Operator control
5.2 Layout of the user interface

SIMATIC Management Console (V9.1 SP1)
Operating Manual, 09/2021, A5E50318373-AB 61



5.3 Configuring the Management Console 

5.3.1 Assigning computers
Once the Management Console has been started, computers on which the "SIMATIC 
Management Agent" is activated attempt to establish communication with the Management 
Console. 
• If communication is successfully established, the computers then appear in the Management 

Console tree structure.
Display: 
"Non-assigned computers" folder in the network view. 

• Computers which have already been assigned to the Management Console always appear in 
the Management Console tree structure.
Display:
Under the  "Network" folder or groups, groups can be created.
Under the "Non-licensed computers" folder.

Requirements
• The user is logged on as the administrator of the Management Console (see section 

"Managing rights (Page 25)").
• Group the computers to ensure that administration tasks in networks can be executed 

efficiently. For additional information refer-
– Section "Create group (Page 66)"
– Section "Delete group (Page 133)"

Assigning computers (establishing identification)
1. Select the "Non-assigned computers" group in the network view.
2. Select a computer.
3. Select the Assign computer command in the shortcut menu.
4. Select the <Group> or the Network folder or Non-licensed computers from the submenu.

Note that only the groups of the first level below the "Network" folder are displayed. 
The identification process is started. 
Note
The "Non-licensed computers" folder can be used only to update SMAgent, determine 
inventory data and export inventory data. This folder groups computers for which a 
corresponding SMAgent license is not installed.
If the identification process between the Management Console and the computer is 
successful, the computer is assigned to the Management Console:
– The computer is moved according to the selection.
– The symbol is updated. 

For additional information refer "Network view (Page 44)"
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Note
Rule for redundant computers
Always insert the computers of a redundant pair into the same group.

Note
Disable assignment   
Removing assigned computers from the management: 
Options:
• Shortcut menu item "Cancel assignment" 
• Use the shortcut menu "Assign computer" to move the computer to the default group "Non-

assigned computer".
• The assignment of the computer to the Management Console can also be made by dragging 

the computer to the default group "Non-assigned computer".
Computers that are not available in the network can be moved to the "Non-assigned computers" 
group. After refreshing the network view, these computers are no longer present in the tree 
structure.

Updating the display
For an update of the information displayed, select:
• the menu command Edit > Update network view 
or
• Press the (F5) key

Computers outside the local network
Computers which are not located in the local network can be manually assigned to the 
Management Console. For additional information refer "Adding computers (Page 63)".

Additional information
• Section "Update or repair SMAgent (Page 67)"
• Section "Disable console assignment (Page 133)"
• Section "Canceling the assignment of a computer (Page 65)"

5.3.2 Adding computers
Computers can be assigned to the Management Console manually. Log on computers to the 
Management Console with this function, even if these computers do not exist in the subnet of 
the Management Console.
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The following are examples of this:
• The computers are located outside the accessible network
• The computers are configured for expansion or change of the network (preparing 

configuration).

Note
Rule for redundant computers
Always insert the computers of a redundant pair into the same group.

Manually assigning computers outside the subnet
The following requirements apply if computers are to be assigned outside the Management 
Console subnet to the Management Console:
• The authorizations are configured.

For additional information refer "Managing rights (Page 25)".
• The gateways are configured.

For additional information refer "Communication using different subnets (Page 34)".
• If the Management Console computer is a member of a domain, the computers to be 

assigned to the Management Console must belong to a trusted domain.

Procedure
1. Select a folder in the network view (network or group).
2. Select the "Add computer..." command in the shortcut menu.

The "Add computer" dialog opens.
3. Enter the name of the computer. Click "OK".

To add multiple computers, separate the computer names with semicolons.

Result
The computers are displayed in the selected folder. The icon in front of the computer name 
indicates the status.
For additional information refer "Symbols in the network view (Page 46)".
When your SMAgent license count is not enough for the inserted target pc, then the target pc 
is added to "Non-licensed computers" node.

Additional information
• Section "Canceling the assignment of a computer (Page 65)"
• Section "Disable console assignment (Page 133)"
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5.3.3 Canceling the assignment of a computer

Disable console assignment       
To assign a computer to a different Management Console, cancel the console assignment to the 
local Management Console. 
Depending on the desired result, choose one of the following options:
Changing the console assignment of individual computers
1. Select the computer.
2. Select one of the following shortcut menu commands:

– Assign computer > Non-licensed computers
– Assign computer > Non-assigned computers

Changing the console assignment of all computers
1. To continue using the configured settings of the Management Console for another computer, 

back up the data.
For additional information refer "Back up data... (Page 131)".

2. Select the menu command "Disable console assignment (Page 133)".
3. Start the Management Console to which the computers of the plant are assigned. Assign the 

computers to this Management Console.

Note
Canceling the assignment of a computer
When the assignment of a computer to a Management Console is removed, the associated pre-
shared key is removed.

Result
The computers are moved to the "Non-assigned computers" group and receive the status "Non-
assigned". For additional information refer "Symbols in the network view (Page 46)".

5.3.4 Reset status
This menu command is used to update the icons displayed at the object.

Procedure
1. Open the Management Console in the network view...
2. Select a single computer, a group, or root "network".
3. Select the menu command "Reset status" from the shortcut menu.
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Additional information
• Section "Update network view (Page 134)"

5.3.5 Create group

Administration of groups 
Group the computers to ensure that administration tasks in networks can be executed 
efficiently. 
• Each computer can be assigned to any group depending on the number of licenses available.
• A computer may either be in no group at all or in a maximum of one group.
The following functions can be executed:
• Create group
• Rename group
• Delete group (Page 133)
A Tree structure with the existing groups in the Management Console network view displays:
• "Network" group
• "Non-assigned computers" group
• "Non-licensed computers" group
• Groups created by an administrator

Requirements
• The user is logged on as the administrator of the Management Console (see section 

"Managing rights (Page 25)").
• Preparation for use of the Management Console is complete.

For additional information refer "Installing the Management Console (Page 28)".
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Create group
Once the Management Console has been started, computers on which the "SIMATIC 
Management Agent" is activated attempt to establish communication with the Management 
Console. If no plant-specific groups have as yet been created, create plant-specific groups and 
assign the computers to the plant-specific groups.
Recommendation:
Working with the Management Console in larger plants becomes more manageable when plant-
specific groups are created(for example, dividing up computers into groups of servers and 
assigned clients; distribution according to plant areas).
1. Select the network folder in the network view.
2. Select the menu command Create group in the shortcut menu.
3. Enter a name for the plant-specific group.

Additional information
• Section "Network view (Page 44)"
• Section ""Edit" menu (Page 133)"
• Section "Adding computers (Page 63)"
• Section "Assigning computers (Page 62)"

5.3.6 Update or repair SMAgent
The shortcut menu function "Update SMAgent..." is only available for target computers on which 
the "SIMATIC Management Agent" is installed.
A prerequisite for using the Management Console is that the version of the "SIMATIC 
Management Agent" installed must be identical to the version of the Management Console to 
which it is assigned to. 
Before updating the SMAgent from V8.2 to a higher version, there must be no pending files on 
the target computer and the same user account must be used which was used in the earlier 
versions to perform SMAgent Update to a higher version.

NOTICE
Computers with SIMATIC BATCH prior to PCS 7 Version 8.1 SP1
The SIMATIC Management Agent cannot be updated via the Management Console.
Install the SIMATIC Management Agent on the local computer via the setup from the following 
folder of the SIMATIC PCS 7 DVD or PCS 7 media: 
Additional_Products > SMA__Vx.x. 
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Note
Updating the "SIMATIC Management Agent" service is prohibited for target computers on which 
one of the following software packages is installed:
• Process Historian
• Information Server
• Web option for OS

– Web Server 
– Web Client or Web Diagnostic Client

Updating the "SIMATIC Management Agent" service is possible as of installed version 8.1.
The "SIMATIC Management Agent" service can be updated  on a target computer on which web 
server is in runtime by enabling the "Web server Settings". For additional information, please 
refer to the section Downward compatibility with the agents (Page 79).
The "SIMATIC Management Agent" service cannot be updated (from an older version to current 
version) on a target computer with SIMATIC Management Console installed on it.

Basic procedure
The following actions are required for updating the "SIMATIC Management Agent" service:
• Update the "SIMATIC Management Agent" service on the target computer using the 

Management Console.
• Deactivate the process mode on the target computer by SIMATIC Management Agent when 

it is necessary for the update. This is because reboots are executed for updates older than 
V8.2.

• Close any open project on the target computer by SIMATIC Management Agent, when it's 
necessary for the update. This is because reboots are executed for updates older than V8.2.

• Update SMAgent.

Note
• Reboot the target computer by the Management console, if necessary.
• Activate the process mode by SIMATIC Management Agent when Autostart is configured.

Computers with different versions of the "SIMATIC Management Agent" service
The Management Console automatically checks the version of the "SIMATIC Management 
Agent" service on each computer. The following versions are compared during the check:
• Version of the service on the Management Console computer
• Version of the service on the target computer in the network
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If the comparison shows a difference in the versions, the respective target computer in the 
network (not the Management Console computer) is marked with the following symbol in the 
network tree view: 

That means, the version of the "SIMATIC Management Agent" is different to the version on the 
Management Console computer and it is not compatible. Only the "Update SMAgent" function 
is available for the computers marked with this symbol. All functions are available after updating 
the service. 
The Management Console can manage and communicate with the SIMATIC Management 
Agents of certain old versions. In that case the following symbol is displayed:

For more information refer Downward compatibility with the agents (Page 79)

Requirements
• The "SIMATIC Management Agent" setup is available on a shared storage path (File server or 

local folder).
• A share has been set up for the user for this storage path.
• The storage path is entered in the "SIMATIC Management Agent" tab. Storage path: "SIMATIC 

PCS 7 DVD or PCS 7 media: Additional_Products > SMA__Vx.x. " or a copy from the SMAgent 
Setup.

• The user is a member of the Windows user group "SIMATIC Management Administrators".

Note
Requirement for shared update of SIMATIC Management Agents (group or multiple 
computers).
When computers are selected for shared update of SIMATIC Management Agents, the same 
version of the SIMATIC Management Agent must be installed on these computers.
Example: 
The shared update of SIMATIC Management Agents of version 8.0 SP2 and version 8.1 SP1 is  not 
possible when the computers are in the same group. An error message will be displayed.
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Procedure
1. Select an object in the network view.

– Network
– Group
– Computer
– Non-licensed computers

2. Select Update SMAgent... from the shortcut menu.
– The "SIMATIC Management Agent Setup" dialog opens.
– The "SIMATIC Management Agent" setup is selected or can be selected if a SIMATIC 

Management Agent Setup has not been entered in the "Settings" option.
3. Select the setup. Click "Next". The "Install SIMATIC software (2/4) - Computer status" dialog 

for the selected setup is displayed.
4. Make the necessary settings. For additional information refer "Dialog "Install SIMATIC 

software (2/4) - Computer status" (Page 91)". 
5. Click "Next".

The "Install SIMATIC software (3/4) - Configure start behavior" dialog opens.
6. Make the necessary settings.

For additional information refer "Dialog "Install SIMATIC software (3/4) - Configure start 
behavior" (Page 92)".

7. Click "Next".
The "Install SIMATIC software (4/4) - Requirements for the installation of the SIMATIC 
software" dialog opens.

8. On the "Install SIMATIC software (4/4) - Requirements for the Installation of the SIMATIC 
software" dialog, you can select the below option to continue with the update: 
"I have read the readme file for the products to be installed. I confirm that I have read and 
understood the installation and security information". 

9. Select both the check boxes:
"I have made sure that no setups are active or have been started by other processes on the 
target computers". 
"I agree that process mode is ended on the target systems".

10.Click "OK".
The actions required to update SIMATIC Management Agent are performed.

Result
The service is updated on all computers that were selected for installation.
Once the update is complete, the status symbol for the computers in the network view is also 
updated.
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Updating the SMAgent on computers in different subnets
If the SIMATIC Management Console and the target computers with installed SIMATIC 
Management Agent are located in different subnets, consider the following criteria: 
• If the computers are supposed to continue communicating across subnet boundaries as they 

did before the SMAgent update, then check or re-establish the system-specific configuration 
of the Windows Firewall.

Additional information
• Installing SIMATIC software (Page 85)
•  Communication using different subnets (Page 34)

5.3.7 Backing up and restoring a project
The general configuration, complete Network and Plant view trees, inventory data, and settings 
for the Management Console can be backed up to a file. Using the saved file, the configuration 
and settings can be restored on any computer with SIMATIC Management Console installed in 
it.

5.4 Using communication

5.4.1 Connecting
As of V8.2, the frames to establish a connection between the Management Console and 
managed computers with installed and activated service "SIMATIC Management Agent" are 
protected by a Pre-Shared Key. 

Pre-shared key 
• The pre-shared key is an application-specific, shared network key that was agreed to 

beforehand. 
The protection only involves the connection frames required for the application of the 
Management Console. The pre-shared key has no effect on the connection frames from other 
applications.

• Enter the pre-shared key for the first application of the Management Console. 
The Management Console automatically assigns the pre-shared key to a computer when it is 
initially assigned to the Management Console.
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Note
Canceling the assignment of a computer
When the assignment of a computer to a Management Console is removed, the pre-shared key 
is removed on this computer.

Note
Make sure that the PSKs (Pre-shared keys) are invalidated in the whole plant (e.g. by setting a 
new PSK using "SIMATIC Management Agent Configurator"), when a SIMATIC Management 
Console computer is decommissioned.

Updating the pre-shared key
Recommendation: Change the pre-shared key regularly. To do this, select the menu 
command Options > Set pre-shared key... .
• The pre-shared key is changed on the Management Console with the following effect:

The update of the pre-shared key is applied to all computers assigned to the Management 
Console if these could be reached until the assignment was completed.

• If a computer assigned to the Management Console cannot be reached for the update of the 
pre-shared key, the following applies:
A message in the alarm/event log of the Management Console indicates the non-updated 
computer. 
Remedy error:
Open the "SIMATIC Management Agent Configurator" locally on the non-updated computer.
For additional information refer "How to change the pre-shared key on a computer at a later 
time  (Page 74)".

Rules for establishing a connection
The following applies to the connection between SIMATIC Management Console and SIMATIC 
Management Agent:

Network in which the computer is located The following applies to the connection:
Management Console Plant computers with 

SIMATIC Management 
Agent

Domain Domain Connection possible
Workgroup Workgroup
Domain Workgroup No connection possible.
Workgroup Domain

• If both connection partners are in a Windows domain, connection is possible.  
The Kerberos protocol is used for the connection. 

• If both connection partners are in a Windows workgroup, connection is possible.
The NTLM protocol is used for the connection. 

• If only one connection partner is a member of the domain, no connection is possible.
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Connection establishment behavior depending on pre-shared key
The following applies regarding connection establishment between Management Console and 
computers in the plant:

Pre-shared key The following applies to the connection:
On the Management 
Console

On the plant computer 
with SIMATIC Manage‐
ment Agent

Same pre-shared key  Connection possible
Pre-shared key No pre-shared key Pre-shared key is saved, connection possible
Pre-shared key Different pre-shared key No connection possible > Message in the event log 

of the Management Console.
Same pre-shared key, but the plant computer is as‐
signed to another Management Console.
Note: A plant may only have one Management 
Console.

Check the connection and correct the settings if 
necessary.
For additional information refer  "Relocate the Man‐
agement Console in the network (Page 37)".

Firewall
PC stations can be located in different subnets in a network. The subnets can, for example, be 
connected by routers and protected by a firewall. The firewall rules must be adapted to allow 
access to the other network in each case. For additional information refer the 
documentation Process Control System PCS 7; PCS 7 - PC Configuration.

Additional information
• Section "Starting the Management Console (Page 39)"
• Section "SIMATIC Management Agent Configurator (Page 73)"

5.4.2 SIMATIC Management Agent Configurator
As of SIMATIC Management Console V8.2, connection frames between the Management 
Console and computers with activated SIMATIC Management Agent are encrypted. 
The pre-shared key must be entered for the first application of the Management Console. 
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"SIMATIC Management Agent Configurator" dialog box 
Information displayed: Meaning
Currently connected SIMATIC Manage‐
ment Console

Displays the name of the computer on which the currently 
connected SIMATIC Management Console is installed.
This entry can be empty when the computer is not connected 
to a SIMATIC Management Console.

Last assigned SIMATIC Management 
Console

Displays the name of the computer to which the local com‐
puter had established a connection with a SIMATIC Manage‐
ment Console.
This entry can be empty when the computer was not connec‐
ted to a SIMATIC Management Console.

Actions with the "SIMATIC Management Agent Configurator" 
Following can be done using the "SIMATIC Management Agent Configurator" application:

Actions Meaning
Reset pre-shared key Deletes the pre-shared key on the local computer that was 

assigned by a SIMATIC Management Console or a user.
New pre-shared key... Opens the dialog box "Set pre-shared key..." .

For more information refer "Set pre-shared key... (Page 139)".
The action only has an effect on the local computer.

5.4.3 How to change the pre-shared key on a computer at a later time 

Note
The Management Console can only establish communication links to computers for which the 
same pre-shared key is configured.

It might be necessary to change the pre-shared key for a computer in a plant at a later time (for 
example, after restoring a configuration by using a backup). 

Requirements
• Administrative rights are required to change the pre-shared key.
• Execute the action on the local computer.

New pre-shared key
1. Open the SIMATIC Management Agent Configurator as administrator in the "Siemens 

Automation" folder from the Windows Start menu.
The "SIMATIC Management Agent Configurator" dialog box opens.

2. Click "New pre-shared key".
The "Set pre-shared key" dialog box opens.
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3. Enter the pre-shared key defined in the Management Console into the input boxes.
For more information refer "SIMATIC Management Agent Configurator (Page 73)".

4. If it matches the pre-shared key, the current Management Console is shown in the dialog 
window.

5. Click "OK".
6. Click "Close".

Reset pre-shared key
1. Open the SIMATIC Management Agent Configurator as administrator in the "Siemens 

Automation" folder from the Windows Start menu.
The "SIMATIC Management Agent Configurator" dialog box opens.

2. Click "Reset pre-shared key".
The pre-shared key is assigned to the computer from the Management Console.

3. Click "OK".
4. Confirm the restart of the SIMATIC Management Service. Click "OK".
5. Click "Close".

5.5 Installing and updating software

5.5.1 Integrity check for PCS 7 software 
The SIMATIC Management Console verifies the integrity of the software to be installed as part of 
the remote software deployment. 

Software integrity check
The software integrity check is performed during the following processes:
• Installing SIMATIC software 
• Updating SIMATIC software 
• Updating SIMATIC Management Agent

Note
As of SIMATIC Management Console V9.1.1, software integrity check functionality is not 
supported for the PCS 7 setups older than V9.1.
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General course of action during Software integrity check:
• The integrity check of setup for all the instances of triggered installations.  
• If the integrity check is successful, the actual remote installation begins on the agent 

computer, and the status updates will be displayed in the "Event display" and "Alarms 
window" of the Management Console. 

• If the integrity check fails, the remote installation will be stopped, and the status will be 
displayed in the "Event display" and "Alarms window" of the Management Console.

Note
• The user is prompted with an option to either allow or deny integrity check before starting an 

installlation/update.
• Simultaneous integrity checks for different computers are allowed only when software 

packages or SIMATIC Management Agent updates are being installed.
• When a granular installation is in progress, installation of a software on a different computer 

will be permitted only after the previously initiated integrity check concludes. 
• If the PCS 7 installation media is placed in a shared path, ensure that it only has read-only 

privileges to prevent setup/external users from making unauthorized changes to the files. 
That way the integrity of the installation media remains intact.

Procedure
By default, Software integrity check will be enabled. To disable/re-enable Software integrity 
check - 
1. Select Options > Settings option. 
2. Open the ‘Software Administration’ Tab. Enable or disable the option - "Software integrity 

check enabled" based on the requirement.
If the "Software integrity check is disabled, a comment must be added in the "Comment on 
selection" window.

3. Click "Finish"
Note
• The results of an integrity check can either be found under the SIMATIC Management 

Console alarms or event displays.
• Integrity check fails when an existing file/folder is deleted or altered in the PCS 7 Bundle.
• Integrity check doesn't fail if a new file/folder is added to the PCS 7 Bundle.
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5.5.2 Software Update

Note
The following computers are changed by the steps to be executed:
• Computers with installed SIMATIC Management Console
• Computers in the plant with installed SIMATIC Management Agent

Prerequisites
• Installed software on the computer with installed SIMATIC Management Console 

– SIMATIC Management Console as of V8.1  
• Required software packages  

– SIMATIC Management Console V9.0; SIMATIC Management Agent V9.0

Basic procedure
The SIMATIC Management Console is updated in four steps:
1. Store the installation files.
2. Back up the configuration and setting data of the SIMATIC Management Console.
3. Update the computer with installed SIMATIC Management Console.
4. Restore the configuration and setting data of the SIMATIC Management Console.

Storing the installation files
1. Use the PCS 7 DVD with the following structure:

– ...\PCS7_Vxx\DVD 　 
2. Use the PCS 7 media with following structure e.g. USB drive: 

– ...\PCS7_Vxx\media
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Note
• The software packages to be installed must be available on a shared path.
• Ensure that the selected path names do not exceed 85 characters when you set the paths for 

the software.
• Select a path with a unique name for each software package. For example:

– \\<Computer>\<Path>\<SMMC_Version_and_Date> (example path for the SIMATIC 
Management Console Vxx software package)

– \\<Computer>\<Path>\<SMA_Version_and_Date> (example path for the SIMATIC 
Management Agent Vxx software package)

• Ensure to unzip only the Web Package. Enable the option "Extract the product without being 
installed".

Backing up the configuration and setting data
To backup the configuration and setting data:
1. Start the "SIMATIC Management Console" application.
2. Select "File > Back up data...".
3. Follow the instructions in the dialogs. The following data is backed up:

– Configuration and setting data
– Inventory data
– Information of the "Event List"

4. Select "Edit > Disable console assignment"
5. Close the "SIMATIC Management Console"

Updating the computer with installed SIMATIC Management Console
1. Open the path in which you have stored the SIMATIC Management Console software 

package. Information on this step is available in paragraph "Basic procedure", step 1: in the 
example "...\SMMC_Version_and_Date" or starts the setup.exe in the PCS 7 DVD or the PCS 7 
media.

2. Start the setup.exe file. Follow the instructions in the dialogs.
3. Perform a restart of the computer once the installation is complete.
The installation of the new version of the SIMATIC Management Console is complete.

Restoring the configuration and setting data
To restore the configuration and setting data of the SIMATIC Management Console. Follow the 
steps outlined below:
1. Start the "SIMATIC Management Console" application.
2. Select "File > Restore data...".
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3. Select the path of the backed up configuration and setting data.
4. Perform a restart of the computer once the restoration is complete.
The restoration of the configuration and setting data is complete.

Result
The update of the SIMATIC Management Console is complete.

5.5.3 Downward compatibility with the agents
The SIMATIC Management Console supports the downward compatibility in the following 
manner:
• The SIMATIC Management Console can communicate with the SIMATIC Management Agents 

of previous SIMATIC Management Console versions, starting with V9.0. 
• Functionality of the SIMATIC Management Console is limited to that of the respective older 

SIMATIC Management Console version.  

Prerequisites
The downward compatible SIMATIC Management Agents must be re-assigned to the SIMATIC 
Management Console application in order to establish communication. 

System behavior for downward compatibility
• When you right click on any computer in the "Network" view, irrespective of the action that 

is chosen, a warning is provided before proceeding to the "SIMATIC Management Console" 
dialog box. Click "Yes/No" depending on the action that needs to be executed on the agent. 

• Computers with SIMATIC Management Agent of version older than V9.0 display a status 
"Version mismatch without compatibility" and the corresponding icon. The SIMATIC 
Management Agent must be updated to the latest version available in order to communicate 
with the SIMATIC Management Console (SMMC). 

• Computers with SIMATIC Management Agent of version V9.x display a status "Version 
mismatch with compatibility" and the corresponding icon. The SIMATIC Management 
Console will be able to communicate with these agents for available functionalities. 

• Functionalities of the SIMATIC Management Console of an older version of the SIMATIC 
Management Agent depend on the agent version and are automatically enabled/disabled in 
the "context/toolbar" menus. 
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• For all the available actions in older agents, the user is prompted with a warning for limited 
functionalities. The user can continue with the limited functionality or cancel the action.

• The limitations in terms of available functionality for older SIMATIC Management Agents are 
listed below:
– The following features introduced in V9.1.1 are not supported in SIMATIC Management 

Agents older than V9.1:
Tracking of Windows Defender events
Automated e-mail configuration for notifying Windows Defender events 

– The following features introduced in V9.1 are not supported in SIMATIC Management 
Agents older than V9.1:
Remote Microsoft update management (disabled in context menu > Network view)  
Microsoft update installation report (disabled in context menu > Network view)

– For SIMATIC Management Agents older than V9.0.1, the following features are not 
supported: 
Determining the station data (disabled in context menu > Plant view) 
Persistence of offline and online data (Plant view) – either offline configuration data or 
online device data can be determined and stored. 

– Determining the network and plant inventory only retrieves attributes supported by the 
corresponding version of the SIMATIC Management Console. Attributes added in the later 
versions are not retrieved.  

– Status of the actions performed by the older SIMATIC Management Agents are not 
reflected in the computer status icon. It continues to display the "Version mismatch with 
compatibility" icon until the agents are updated to the latest version available.

5.5.4 Installing and updating software-Overview

Requirements
• The software to be installed is available from one shared storage location (shared network 

path, for example \\<Computer name>\<Shared name>).
• A share has been set up for the user for this storage path of the software.
• The user is a member of the Windows user group "SIMATIC Management Administrators". 
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Note
Installation 
Updating software using the Management Console is not permitted for some software and 
package installations of PCS 7. 
The following software and package installations of PCS 7 can only be distributed as new 
installations with the SIMATIC Management Console:
• Process Historian
• Information Server
• OpenPCS 7 (update of the "SIMATIC Management Agent" service possible as of installed 

version 8.1).
• Web Option for OS 

(Web Client or Web Diagnostic Client: Updating the "SIMATIC Management Agent" service is 
possible as of installed version 8.1).

This software needs to be manually installed for a software update.

Note
Adding computers to process mode using autostart
Make sure that starting a computer with a modified installation is not going to cause plant faults. 
This is particularly important when installing software on computers in redundant systems. 
Take particular care with computers for process mode with the following software:
• PCS 7 OS
• SIMATIC BATCH
• SIMATIC Route Control

Note
Dependency of the interface language
In the case of an installation using the Management Console, the following applies to a software 
installation or update:
The installation depends on the language that was set on the Management Console:
• When a setup package is created
• When software is updated
If this language is not available, the software will be installed by the Management Console in 
English and needs to be switched after installation.
Set the interface language of the Management Console accordingly before updating 
software or creating a setup package.

Note
Transferring and updating license keys
This function requires the Automation License Manager.
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Functions of the setup management

Note
Installation of software packages without user input
Only SIMATIC products made available by PCS 7 can be installed without user input. 

Note
Disclaimer of liability
Siemens accepts no liability for any damage which may occur as a result of the use of the 
Management Console for the installation of software which has not been approved. 

Follow the steps below to install software packages: 
1. Enter the storage locations of software packages in the Management Console

Function: Setup management... (Page 145)
2. Optional: 

Settings for software packages with configuration-specific setup dialogs 
Function: Settings... (Page 140)

3. Putting together software packages
Function: Setup packages (Page 83)

4. Installing the software packages on selected computers and groups 
Function: Installing SIMATIC software (Page 85) or Updating SIMATIC software (Page 88)
NOTICE
Operating target computers during software installation
To avoid undefined states, the following actions are prohibited during the software 
installation:
• Operation of target computers.
• Switching the operating mode. 

No check for incomplete installations
After installing software, it might be necessary to restart the computer. This restart is used to 
apply settings in the operating system. If the computer is not restarted before carrying out an 
additional installation, inconsistent operating states may occur. When using the Management 
Console to install or update software, pending requests to restart are executed automatically.
Ensure that there are no pending requests for a restart, to avoid restarting of the computer after 
installing or updating software. 
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5.5.5 Setup packages
Management Console can be used to efficiently install softwares with identical settings on 
computers.
• To prepare for software installation, create setup packages using the Management Console. 
• To install the software, you only select the computers or computer groups and the setup 

package. 

Note
Updating software
Need not create setup packages for updating software using a PCS 7 DVD as of PCS 7 V8.0 SP2.
The setups must be known to the Management Console. 
For additional information refer:
• Section "Preface; Table 2-1 Overview of the most important changes (Page 14)"
• Section "Setup management... (Page 145)"
• Section "Updating SIMATIC software (Page 88)"
 Multiple setups cannot be selected while updating the software.

Setup packages 
Save the following with a plant-specific name in a setup package:
• Combinations of setups which can be installed without configuration-specific setup dialogs.
• Settings for a SIMATIC setup program with configuration-specific setup dialogs

– Example: Settings in the PCS 7 setup to install multiple software packages using a setup 
package. To create a setup package, start the setup of PCS 7 on the Management Console. 
Setup runs in configuration mode. The selected installation parameters are stored in a 
setup package file.

– When making the selection, note that specific settings are required for certain software 
packages. For additional information refer:"Settings... (Page 140)".

Names of plant-specific setup packages can be found under the "Setup packages" tab in the 
"Setup management" dialog.
Select only one setup package for installation. New interactive entries need not be created in the 
setup dialogs of the software packages contained in the setup package. 

Requirement
The setup packages have been entered in the Setup management in the "Setups" tab.
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List of setup packages
1. Select the menu command Options > Setup management.

The "Setup management" dialog opens.
2. Open the "Setup packages" tab.

The list of setup packages is displayed in the "Setup management" dialog.
Note
List of setup packages 
If a setup package includes a number of software packages for PCS 7 setup, the displayed 
information can be expanded for the setup package in the list by clicking "+".
The contained software packages are displayed.

Add setup package
1. Open the list of setup packages (menu command Options > Setup management > "Setup 

packages" tab).
2. Click "Add".
3. Enter a name for the setup package. Click "Next".
4. In the "Setup packages" list, select the setup of the software package that is to be installed.

Note
Only the setups (plant-specific setups) entered in the "Setups" tab in the "Setup 
management" dialog can be selected. If the desired setup is unknown, add it to the list in the 
"Setups" tab.

5. Click "Next".
If a SIMATIC setup which requires configuration-specific setup dialogs for software 
installation is selected, these dialogs open and the settings are saved in the setup package.

6. Click "Next".
The summary for the setup package is displayed.
Supplementary information can be added in the "Comment on setup" input box.
This information is displayed when the setup package is selected.

7. Click "Finish".
The setup package is adopted in the list in the "Setup packages" tab.

Remove setup package
1. Open the list of setup packages (menu command Options > Setup management > "Setup 

packages" tab).
2. Select an entry in the table.
3. Click "Remove".

The "Confirm removal" dialog opens.
4. Confirm by clicking "Yes". 

The setup package is removed from the list. 
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Additional information
Section "Setup management... (Page 145)"

5.5.6 Installing SIMATIC software
Install software with the Management Console as of the following: 
Process Control System; SIMATIC PCS 7; V9.1 with the latest service packs.

Requirements     
• The computers on which the software is to be installed are assigned to the Management 

Console.
• All the necessary permissions have been set up. For additional information refer "Managing 

rights (Page 25)".
– The user is a member of the Windows user group "SIMATIC Management Administrators".
– The software to be installed is available from one shared storage location (shared network 

path, for example \\<Computer name>\<Shared name>).
– A share has been set up for the user for this storage path of the software.

• Setups and software packages are entered in the Management Console. 
For additional information refer "Setup management... (Page 145)".

• Observe the information in the section "Settings... (Page 140)".
• Computers of a redundant pair must be assigned to the same group. 

Note
Installing a redundant server pair
If the partner computer is not recognized as fully available, the Management Console rejects the 
installation of software packages in process mode. In process mode, the servers of a redundant 
server pair can only be installed one after the other for availability reasons (mutual exclusion of 
readiness for installation). 
Try to identify the servers that belong to a redundant server pair in the detailed information 
about the computer (see section "Dialog "Install SIMATIC software (2/4) - Computer status" 
(Page 91)".
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Note
Number of simultaneous remote installations
With the SIMATIC Management Console, software packages can be installed on multiple 
computers at the same time. The number of computers on which an installation can be carried 
out at the same time depends on the following factors:
• Performance/speed of the network
• Performance of the file server (Storage location of the PCS 7 media)
Do not carry out a remote installation on more than 20 to 30 computers at the same time in order 
to avoid an overload. This is provided that no other actions (for example, inventorying) are 
running on the SIMATIC Management Console computer. 

Note
Computers with hard disk encryption/activated BIOS password
Some software packages require a restart of the computer during or after installation of the 
software.
If passwords must be entered for computers after a restart (BIOS, hard disk encryption, etc.), the 
remote installation cannot be completed without "local" operator input when you use the 
SIMATIC Management Console.

Recommendation
1. To install the same software packages on multiple computers, create installation-specific 

groups (OS Client, for example). 
2. Assign the computers to an installation-specific group. 
3. Apply the setup package to the group.
For additional information refer "Assigning computers (Page 62)".

Procedure

NOTICE
Possible restart due to installation
Please note that installing software may initiate a restart of the target computer.

Operator control
5.5 Installing and updating software

SIMATIC Management Console (V9.1 SP1)
86 Operating Manual, 09/2021, A5E50318373-AB



1. In the network view, select the object on which software or a software package should be 
installed. 
Possible selection:
– A computer
– A group

2. Select the shortcut menu command Install SIMATIC software....
The "Install SIMATIC software (1/4) - Select software" dialog window is displayed.
For additional information refer "Dialog "Install SIMATIC software (1/4) - Select software" 
(Page 91)".

3. Select the setups/setup packages. Click "Next".
The "Install SIMATIC software (2/4) - Computer status" dialog for the selected setup/setup 
package is displayed.

4. Make the necessary settings.
For additional information refer "Dialog "Install SIMATIC software (2/4) - Computer status" 
(Page 91)".

5. Click "Next".
The "Install SIMATIC software (3/4) - Configure start-up behavior" dialog opens.

6. Make the necessary settings.
For additional information refer "Dialog "Install SIMATIC software (3/4) - Configure start 
behavior" (Page 92)".

7. Click "Next".
The "Install SIMATIC software (4/4) - Requirements for the installation of the SIMATIC 
software" dialog opens.

8. Make the necessary settings.
For additional information refer "Dialog "Install SIMATIC software (4/4) - Requirements for the 
installation of the SIMATIC software" (Page 94)".

9. Click "OK".
The actions required for the installation of the selected software are performed.

Note
• On the "Setup package" tab, you can only select one setup package to install. 
• Multiple setup packages cannot be installed on the same computer simultaneously and if the 

setup package is selected, then all the products configured for the setup gets installed on the 
computer. 

Show progress
The number of plant components and component availability may mean the process can take 
some time.
The symbol "Action running" is displayed for the status of a group during an action. Detailed 
information is displayed within the group at the computer symbol.
Information on the symbols is available in the section "Symbols in the network view (Page 46)".
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If error messages come up in the Management Console, refer the following section: 
"Determining the cause (Page 123)".

Note
No check for incomplete installations
After installing software, it might be necessary to restart the computer. This restart is used to 
apply settings in the operating system. 
• If the computer is not restarted before carrying out an additional installation, inconsistent 

operating states may occur. When using the Management Console to install or update 
software, pending requests to restart are executed automatically.

• To skip restarting of the computer after installing or updating software, make sure that there 
are no pending requests for a restart. 

Note
Software installation timed-out notification
The time-out notification occurs in the "Alarms" window, when the software installation to the 
assigned computer from the Management console takes more than 12 hours. The installation 
status of the assigned computer can be monitored even after the time-out notification occurs.

5.5.7 Updating SIMATIC software
Update software with the Management Console as of the following version: 
Process Control System; SIMATIC PCS 7; V9.1 with the latest service packs

Requirements
• Software is to be updated from the PCS 7 media.
• The computers on which the software is to be installed are assigned to the Management 

Console.
• All the necessary permissions have been set up. For additional information refer  "Managing 

rights (Page 25)".
– The user is a member of the Windows user group "SIMATIC Management Administrators".
– The software to be installed is available from one shared storage location (shared network 

path, for example \\<Computer name>\<Shared name>).
– A share has been set up for the user for this storage path of the software.

• Setups are entered in the Management Console. 
For additional information refer "Setup management... (Page 145)".

• Observe the information in the section "Settings... (Page 140)".
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Note
Updating a redundant server pair
In process mode, the servers of a redundant server pair can only be updated one after the other 
for availability reasons (mutual exclusion of readiness for installation). 
Identify the servers that belong to a redundant server pair in the detailed information about the 
computer (see section "Dialog "Install SIMATIC software (2/4) - Computer status" (Page 91)".

Note
Number of simultaneous remote accesses
Using PCS 7 Setup, installed software can be simultaneously updated on multiple computers 
with the SIMATIC Management Console. The number of computers on which a simultaneous 
update can be carried out depends on the following factors:
• Performance/speed of the network
• Performance of the file server (storage location of the PCS 7 media)
Do not carry out a remote update on more than 20 to 30 computers at the same time in order 
to avoid an overload. This is provided that no other actions (for example, inventorying) are 
running on the SIMATIC Management Console computer. 

Note
Computers with hard disk encryption/activated BIOS password
Some software packages require a restart of the computer during or after installation of the 
software.
If passwords must be entered for computers after a restart (BIOS, hard disk encryption, etc.), the 
remote installation cannot be completed without "local" operator input when you use the 
SIMATIC Management Console.

Procedure

NOTICE
Possible restart due to installation
Please note that installing software may initiate a restart of the target computer.

Note
• Multiple setups cannot be selected while updating the software.
• Select only the setup.exe files from the PCS 7 setup.
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1. In the network view, select the object on which software should be updated from the PCS 7 
setup. 
Possible selection:
– A computer 
– A group

2. Select the shortcut menu command Update SIMATIC software....
The "Install SIMATIC software (1/4) - Select software" dialog window is displayed.
For additional information refer "Dialog "Install SIMATIC software (1/4) - Select software" 
(Page 91)".

3. Select the setup. Click "Next".
The "Install SIMATIC software (2/4) - Computer status" dialog for the selected setup is 
displayed.

4. Make the necessary settings.
For additional information refer "Dialog "Install SIMATIC software (2/4) - Computer status" 
(Page 91)".

5. Click "Next".
The "Install SIMATIC software (3/4) - Configure start-up behavior" dialog opens.

6. Make the necessary settings.
For additional information refer "Dialog "Install SIMATIC software (3/4) - Configure start 
behavior" (Page 92)".

7. Click "Next".
The "Install SIMATIC software (4/4) - Requirements for the installation of the SIMATIC 
software" dialog opens.

8. Make the necessary settings.
For additional information refer "Dialog "Install SIMATIC software (4/4) - Requirements for the 
installation of the SIMATIC software" (Page 94)".

9. Click "OK".
The actions required for the installation of the selected software are performed.

Note
Progress display
The number of plant components and component availability may mean the process can take 
some time.
The symbol "Action running" is displayed for the status of a group during an action. Detailed 
information is displayed within the group at the computer symbol.
Information on the symbols is available in the section "Symbols in the network view (Page 46)".
If error messages come up in the Management Console, refer to the information in the section 
"Determining the cause (Page 123)".
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5.5.8 Dialog window "Install SIMATIC software" (Update SIMATIC software)

5.5.8.1 Dialog "Install SIMATIC software (1/4) - Select software"
In this dialog box, configure settings based on the setup target:

Setup target Selection
Groups Select the PCS 7 Setup.
Computer Select the software/software packages you want to install or update.

Note
Setups that are not integrated in PCS 7 Setup 
These software packages (WinCC Update, for example) can only be installed using the 
Management Console, if the following requirements are met:
• No input is required in the Setup dialogs during the execution of the setup.
• A setup package has been created for this product.

5.5.8.2 Dialog "Install SIMATIC software (2/4) - Computer status"
The "Computer status" dialog opens when setup packages are installed using the Management 
Console. Computer-specific information is displayed:

Column Identification Meaning
Run setup Check box selected The computer is selected for the installation.

Check box cleared The computer is not selected for the installation. 
For additional information refer "Computer is not ready for installation 
(Page 127)".

Check box grayed out The computer cannot be selected for the installation.
For additional information refer "Computer is not ready for installation 
(Page 127)".

Status (ready for instal‐
lation)

Ready for installation

The computer is ready for installation.

Not ready for 
installation

The computer is not ready for installation.
For additional information refer "Computer is not ready for installation 
(Page 127)".
 

Status unknown

The status of the computer has not been determined yet.
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Column Identification Meaning
Detailed information + / - Use this symbol in the tree structure to display the determined computer-

specific information:
• Computer name
• Information on the role of a computer 

– PCS 7 Operator Stations
– SIMATIC BATCH
– SIMATIC Route Control
– Engineering station

• Information for redundant computers
– Redundancy information (master/standby - redundant partner)
– Redundancy switchover (is possible/is not possible)

• Information for special PCS 7 software packages
For additional information, refer to the section "Computer is not ready for 
installation (Page 127)".

Computer  • Name of the computer
• Role of the computer
• Software package that is installed

Note
Update software on redundant computers
The simultaneous updating of a pair of servers in process mode is blocked in the Management 
Console.
Recommendation:
1. First update the computer which is not the current master. 
2. After this update and completing any necessary measures and any adjustment procedures 

that may be necessary, switch the master over. 
3. After this, update the partner computer of the updated computers.

"Select all" or "Deselect all" button
Only for selectable check boxes.
• "Select all" button

Selects the "Run setup" check box for all available computers.
• "Deselect all" button

Clears the "Run setup" check box for all available computers.
Note the additional information in the table in this section.

5.5.8.3 Dialog "Install SIMATIC software (3/4) - Configure start behavior"
The "Configure start behavior" dialog opens while  installing setup packages using the 
Management Console.
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Information on the automatic launch of process mode for the computers selected for installation 
is displayed.

Automatic launch of process mode
For each computer, the Management Console checks whether the "Launch process mode" 
option is run automatically after switch-on (or restart). If the relevant entries are found for a 
given computer, the "Restore startup type" check box for this computer is available in the 
"Configure start behavior" dialog. 
Default setting: "Restore start type" check box cleared

"Restore start type" check 
box cleared

Meaning

Grayed out No entries for the automatic launch of process mode have been found 
on the computer.

Disabled Entries for automatic launch of process mode were found. These set‐
tings are reset after installation of the software. 
Note:
If the "Restore start type" option was enabled before the software was 
installed, enable automatic launch of process mode for establishing the 
plant-specific startup behavior after installing the software.

Selected If the user selects the "Restore start type" check box, the original settings 
for the automatic launch of process mode are retained. 
Caution!
• Additional steps are required for certain installations.
• Please note that startup sequence cannot be set up for the comput‐

ers.

"Select all" or "Deselect all" button
Only for selectable check boxes.
• "Select all" button

Selects the "Restore start type" check box for all available computers.
• "Deselect all" button

Clears the "Restore start type" check box for all available computers.
Note the additional information in the table in this section.
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5.5.8.4 Dialog "Install SIMATIC software (4/4) - Requirements for the installation of the 
SIMATIC software"

Setting the options
Installation can be done only after the following settings are specified:
• Activated option button "I have read the readme file for the products to be installed. I confirm 

that I have read and understood the installation and security instructions."
• Activated check box "I have made sure that no setups are active or have been started by other 

processes on the target computers".
• Activated check box "I agree that process mode is ended on the target systems".
Additionally, to update the software for a group-
• Select the option "I accept the terms of the above license agreements and confirm that I have 

read and understood the security information".

5.5.9 Create installation report...
This function provides information about the software installation for the selected period in a 
report.

Requirements
• Note the following in the section "Preface; Table 2-1 Overview of the most important changes 

(Page 14)".
• The installed software packages were installed with PCS 7 Setup as of PCS 7 V8.0 SP2.

Software installations of separate products support the installation report only with the 
following information:
– Installation started message.
– Installation completed message.

• The installation procedures in the report period were started using this Management 
Console software package. 

Procedure
1. Select one of the following objects in the network view:

– Network
– Group
– Computer

2. In the shortcut menu, select the command Create installation report...
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3. Select a reporting period and a storage location.
Input options: 
– Start: Date
– End: Date
– Define the file and location for the installation report:

- Click the "..." button:
- Select the folder in which the file is to be saved.
- Change the file name if required.

4. Click "Save".
The installation report is generated in PDF format.

5.5.10 Microsoft Software Updates installation

Microsoft software update management
The Microsoft software update management provides the following:
• Allows the user to install Microsoft (MS) software updates on all the target computers in 

which SIMATIC Management Agent is installed. 
• Follows the same set of steps executed during the deployment of SIMATIC software updates.
• Reports information about Microsoft (MS) software updates that are already installed and 

the ones that are currently being installed.
• Updates the user about the progress and status of the update deployment.

Note
• Microsoft (MS) software updates might take several hours for a computer that is being 

updated every month regularly under normal conditions.
• The SIMATIC Management console remotely deploys the Microsoft software updates from 

WSUS (Windows Server Update Services) to WUA (Windows Update Agent) on each target 
computer using the SMA (SIMATIC Management Agent).

Prerequisites for a Microsoft software update
The following are the requirements that a user needs to ensure before deploying the Microsoft 
software update:
• Clean up the system drive
• Ensure that at least 10GB of free space is available in the system. 
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Installing Microsoft software updates
Perform the following steps to install the Microsoft (MS) software updates:
1. In the network view, select the target computer in which the Microsoft software updates are 

to be installed.
2. Select "Install Microsoft software updates" from the context menu.

The "Install Microsoft software updates (1/3) - Select computer" dialog window is displayed.
3. Select the computer on which the updates are to be installed. Click "Next".

The "Install Microsoft software updates (2/3) - Select start up" dialog window is displayed.
4. Select startup type after the update management. Click "Next". 

The "Install Microsoft software updates (3/3) - Requirements for the installation of the 
Microsoft software updates" dialog window is displayed.

5. Enable the setup disclaimer option. Click "Finish".
A confirmation message is sent to the target computer for user approval.

Note
• Microsoft software updates cannot be deployed on the target computers in which one of the 

following software packages are installed:
– Process Historian
– Information Server

• Do remember that the context menu option - "Install Microsoft software updates" is enabled 
by default, but the Microsoft software updates installation feature is only available for 
SIMATIC Management Agents of version V9.1 or higher.

Deployment
The SIMATIC Management Console pops-up a confirmation box in the target computers, for the 
operator to confirm the deployment of Microsoft software updates in the respective computers. 
The operator can either choose to confirm or postpone.

Note
• Selecting the "Postpone" button closes the window which re-appears after the configured 

time interval. In case the message window is not confirmed or postponed within the 
configured time-out, a confirmation is assumed automatically. 

• For information on the WSUS, please refer Process Control System PCS 7; Compendium Part 
F – Industrial Security.
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Microsoft software updates
• Navigate to Options > Settings option, select the "Microsoft software updates" tab.
• Configure the postponement related settings - postpone duration, maximum number of 

postpones and the message window time-out based on the requirement.
• Click "OK" to confirm the same.

Based on the configured settings, a confirmation box pops-up in the target computers. 

Reporting the installed Microsoft software updates
The progress of Microsoft software updates being updated on the target computer is displayed 
in the SIMATIC Management Console alarms window. 
The successful completion or an aborted update is reported. The first inventory of a computer 
following an update identifies the newly installed updates as a part of the Microsoft software 
inventory.
The SIMATIC Management console provides an installation report for the deployment of 
Microsoft software update similar to an installation report for SIMATIC software deployment.
Generating the report
1. Select the computer in the "Network" view.
2. In the context menu, select the command "Create Microsoft software updates installation 

report". 
The "Create Microsoft software updates installation report" dialog box appears.

3. Select a reporting period and a storage location. 
 - Input options:    
    - Startdate
    - Enddate
 - Define the file and location for the installation report: 
     - Click the "..." button: 
     - Select the folder in which the file is to be saved.
     - Change the file name if necessary.

4. Click "OK". 

Error handling
• The Management Console monitors the duration of the following phases during the 

deployment of the Microsoft software updates with a defined time limit:  　 

Phase Duration before timeout cancellation [hours]
Download from WSUS 1
Installation on target computer 1
Complete deployment ∼12

• Messages related to the progress and status of the installation process are displayed in the 
message window, and are logged as events.

For more information on Microsoft updates, please refer Microsoft Support (https://
support.microsoft.com/)
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Windows Update
Windows Update ("Settings > Update & Security") may display updates that have already been 
installed via the SIMATIC Management Console under "Available updates" in the target 
computer. Since, the updates are deployed via the SIMATIC Management Console and the 
scanning is done by Microsoft, there might be a small delay in the status update at Microsoft's 
end. To be sure about the installation status, check the "Alarms" window of the SIMATIC 
Management Console. 
To get a detailed overview of the updates, please export the Microsoft software updates 
installation report. If the status does not get updated in the respective target computer, click on 
"Install now" or "Check for updates" in the "Windows Update" dialog box, to initiate a scan.

5.6 Determine inventory data
The "Determine inventory data" function causes the Management Console to gather 
information from the plant for a selected object. 
• In the network view, call the function from the shortcut menu of the following objects in the 

tree:
– Network
– Group with assigned computers 
– An assigned computer 
– Non-licensed computers

• In the plant view, call the function from the shortcut menu of the following objects in the tree:
– Multiproject
– Project
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Information displayed
 Network view Plant view
Requirements The network computers must be assigned to 

the Management Console.
For more information refer-
• Section "Create group (Page 66)"
• Section "Assigning computers (Page 62)"
• Section "Adding computers (Page 63)"

The PCS 7 project must be known, including 
the associated Engineering Station.
For more information refer-
• Select Engineering Station:

Section "Settings... (Page 140)"
• Select PCS 7 project:

Section ""Add plant" overview (Page 104)"
"Inventory data" tab To access the following, select Inventory da‐

ta>Installed software>Installed third-par‐
ty software:
• Hardware information and Operating sys‐

tem configuration.
• Installed version of Microsoft .NET Frame‐

work and Microsoft SQL server with ver‐
sion number 

• Microsoft patches with Product name, 
Publisher, title, KB and installation date.

• Installed security software with manufac‐
turer, product, version (Windows Defend‐
er, McAfee Agent, McAfee Application 
Control).

Display project-specific information for the fol‐
lowing objects:
• Automation systems
• Field devices
• Network components
• License name and Process Object count

"SIMATIC software" tab Information on SIMATIC software installed on 
the computers
For additional information, refer to the sec‐
tion ""Installed SIMATIC software" tab 
(Page 51)" 

No information

"License keys" tab • Information on the license keys installed 
on the computer; 
Only the following states are displayed in 
the "License status" column: 
– Installed
– Used

• Detailed information on license keys can 
be obtained with the Automation License 
Manager. 

For additional information, refer to the sec‐
tion ""License keys" tab (Page 52)" 

No information

"Device status" tab • Information on the device status of a 
computer 

• Status information
• Operating states
For additional information, refer to the sec‐
tion ""Device status" tab (Page 53)" 

No information
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Basic procedure
1. Select view
2. Select object
3. Determine inventory data

For more information refer-
– "Determining inventory data in the network view (Page 101)"
– "Determining inventory data in the plant view (Page 106)"

5.6.1 Requirement for the "Determine inventory data" function
Assign user-specific names and descriptions in projects. 

Requirement for the "Determine inventory data" function 
When using the "Determine inventory data" function, please note that the following characters 
are not permitted in user-specific names and descriptions:
! " § $ % & / ( ) = ? ´ + # ' < >

Checking and adapting
If inventory data cannot be determined for an object, carry out the following steps:
1. Check all the characters in the user-specific names or descriptions for the device in SIMATIC 

Manager.
2. Adapt the configuration.
3. Determine the inventory data again.

Example of a user-specific device name
• Virtual adapter name for SOFTNET IE RNA 

Determining information about switches and field devices
For more information refer "Determining inventory data in the plant view (Page 106)".
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5.6.2 Inventory data in the network view

5.6.2.1 Determining inventory data in the network view
Using the "Determine inventory data" shortcut menu command, update the information shown 
in the details area of the Management Console.

Note
Delayed display on the Management Console
Actions on the SIMATIC Management Console that are executed in addition to the action 
"Determine inventory data" can cause a delayed display on the Management Console.

Requirements
The computers for which the information is to be determined must be assigned to the 
Management Console.

Procedure
1. Select the object for which you want to determine inventory data:

– Network
– Group
– Computer
For example, Inventory data of the hard disk in the computer
The following inventory data of the hard disk in the computer from the "Installed hardware" 
can be determined:
– Size
– Driver date
– Driver name
– Driver version
– Manufacturer
– Serial number
– Type

2. Select the Determine inventory data...  command in the shortcut menu for the object.
The "Determine inventory data" dialog window opens.
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3. The following options are already selected by default. If only some of the information should 
be determined (e.g. only the license keys), the other check boxes can be cleared.

Options Meaning
"Determine computer information" check box Obtains the device-specific data. 1)

"Determine license keys" check box Obtains the installed license keys.1)

"Determine SIMATIC software" check box Obtains the installed SIMATIC software.1)

1) The object data is obtained from the PCS 7 plant online.
4. Observe the following notes:

Click "OK".
The inventory data is determined. 
Note
Show progress
The duration of the process depends on the number and availability of the plant components.

NOTICE
Inventory data is not determined
Please note that inventory data is not determined when the Management Console is ended 
during determination of inventory data.

Result
After the inventory data was successfully determined, it is shown in the detail view in the 
"Inventory data" tab.
Detailed information is displayed within the group at the computer symbol.
For more information refer "Symbols in the network view (Page 46)".

Additional information
• Section "Exporting inventory data in the network view (Page 102)"
• Section "Determining the cause (Page 123)"
• Section ""Details area" overview in the network view (Page 50)"
• Section ""Determine inventory data" not executed (Page 128)"

5.6.2.2 Exporting inventory data in the network view
The Management Console exports the inventory data of objects in the network view 
automatically after successful determination of inventory data. Export is possible for the 
following objects:
Objects of the network view (export format of file: XLSX) 
• All managed computers under network
• All managed computers under a group
• Export the inventory data of a single, selected computer
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Exported data
The following data is exported depending on the selected basic object:
Basic object in the network view
The following data is displayed:
• Computer
• Hardware data
• Licenses
• Installed SIMATIC software
• Installed third-party software (To access the following information, select Inventory data > 

Installed software > Installed third-party software).
– SQL Server
– Installed version of Microsoft .NET Framework with version number
– Microsoft patches with Product name, Publisher, Title, KB and installation date.
– Installed security software with manufacturer, product, version (Windows Defender, 

McAfee Agent, McAfee Application Control).

Windows Defender events and signature version
Signature version is important information about the current state of the antivirus software. 
After the determination of computer inventory, the signature version is read only for Windows 
Defender by the SIMATIC Management Console. 
The SIMATIC Management Console inventory information of virus protection provides the 
additional information regarding the installed signature version for the "Windows Defender". 

Requirement
• The inventory data for the basic object has been determined.
• For more information refer "Determining inventory data in the network view (Page 101)".

Procedure
The information shown in the details area can be exported to a file.
1. Select the basic object and choose one of the following actions:

– Select the Export inventory data... command in the shortcut menu
– In the toolbar, click the "Export inventory data" button.
– Click the "..." button:

The "Export inventory data" dialog window opens.
- Select the folder in which the file is to be saved.
- Change the file name if required.
- Select the cover page.

2. Click "OK".
The information is exported.
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The file name of the export inventory data file is displayed in the format: <default folder 
path>_<file name>_<time stamp>.

Note
• The location path for the export inventory data can be specified on the "Inventory Export" tab. 

For more information see, "Settings...". This setting is applicable only for automatically 
generated export inventory data files.

Opening exported inventory data
The exported inventory data can be opened for further use:
The recommended program is Microsoft EXCEL (XLSX file)
The versions of programs recommended for use with PCS 7 can be found in the PCS 7 Readme 
online on the Internet. 

Additional information
Section "Saving information in files (Page 128)"
Section "Identifying errors (Page 123)"

5.6.3 Inventory data in the plant view

5.6.3.1 "Add plant" overview
The PCS 7 projects on the engineering station contain important details on PCS 7 plants. When 
determining the inventory data, the Management Console reads some of this data from the 
project. 

Requirement
• The engineering station is set (menu "Options > Settings"; tab "Specify Engineering Station").

For more information refer "Settings... (Page 140)".
• The projects to be selected must be known on the engineering station in SIMATIC Manager.
• Ensure that no changes are made to the engineering station while the projects are being 

determined.

Procedure
The "Add plant" dialog box contains the following steps for preparing for determining inventory 
data:
1. Specify engineering station (Page 105) 
2. Select projects (Page 105)
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5.6.3.2 Dialog window "Add plant (1/2) - Specify Engineering Station"
The PCS 7 projects on the engineering station contain important details on PCS 7 plants. When 
determining the inventory data, the Management Console reads some of this data from the 
project. 
The "Add plant" dialog box contains the following steps for preparing for determining inventory 
data:
1. Select Engineering Station 
2. Select projects

Requirement
• The engineering station is set (menu "Options > Settings"; tab "Specify Engineering Station").

For more information refer "Settings... (Page 140)".
• The projects to be selected must be known on the engineering station in SIMATIC Manager.
• Ensure that no changes are made to the engineering station while the projects are being 

determined.

Procedure
1. Open plant view in the Management Console.
2. Select the Add plant...  command in the shortcut menu.

The dialog window "Add plant (1/2) - Specify Engineering Station" opens.
Note
• If no Engineering Station has been entered, the following alert box appears: "Please first 

define an Engineering Station under "Options".
For more information refer "Settings... (Page 140)".

• When a previous inventory is in the network view only the computers with an installed 
engineering station can be selected.

3. In the drop-down list, select the engineering station from which PCS 7 plant multiprojects/
projects are to be added.

4. Click "Next".
The "Dialog box "Add plant (2/2) - Select projects" (Page 105)" dialog box opens.

5.6.3.3 Dialog box "Add plant (2/2) - Select projects"
In this dialog, choose the projects from which the inventory data are to be determined.

Requirements
• Select the engineering station on which the projects are available.
• In SIMATIC Manager make sure to get access to the selected projects.
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Procedure
1. In the list, select the multiproject/project.

Note
List of multiprojects/projects
Users of the Management Console can determine the inventory data without entering a 
password since the Management Console only has read access to projects. For more 
information refer "Managing rights (Page 25)".
The following projects of the selected engineering station can be found in the list:
• PCS 7 multiprojects/projects displayed in the SIMATIC Manager
• Blocked / password-protected PCS 7 multiprojects/projects

2. Click the "Finish" button.

Result
The Management Console is ready to determine the inventory data for the selected project.

5.6.3.4 Determining inventory data in the plant view
Using the "Determine inventory data" shortcut menu command, update the information shown 
in the details area of the Management Console on the "Inventory data" tab.

Note
Delayed display on the Management Console
If actions are performed in addition to the "Determine inventory data" action in the SIMATIC 
Management Console, it is possible that the additional actions will delay the display on the 
Management Console.

Requirements
• The computers for which the information is to be determined must be assigned to the 

Management Console.
• To obtain PCS 7 project-specific inventory data via plant view: 

– The Management Console is able to access the engineering station data.
For more information refer "Managing rights (Page 25)".

– The engineering station has been specified.
For more information refer "Settings... (Page 140)".

– The PCS 7 project assigned to the plant has been selected.
For more information refer ""Add plant" overview (Page 104)".
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• To determine inventory data of a PCS 7 project on an engineering station, observe the 
following points:
Ensure that, during determination of the inventory data, no changes are made to the project 
for which inventory data is being determined. Note that the project can be stored in the 
following locations:
– On this engineering station
– On another engineering station
– On a project server

• A member of the "SIMATIC Management Users" group is logged onto the engineering station.
This user is a member of the "SIMATIC NET" group on the engineering station.

• All changes on the engineering station are complete.

Note
Inventory data of switches
If inventory data from switches is determined offline, only the following information about the 
switch is available:
• Switch name 
• IP address 
If inventory data of switches is to be determined online, the following conditions must also be 
fulfilled:
• A PCS 7 Maintenance Station (ASSET Management) is configured in your PCS 7 project.
• The switches are configured on this Maintenance Station. 
• The user logged on to the engineering station is a member of the following groups:

– On the engineering station: Member of the local group "Administrators" (the member 
does not have to be logged in as an administrator)

– On the maintenance station: Member of the group "SIMATIC NET"
• On the Maintenance Station, where the switches are configured in the SIMATIC Net-

configuration of Siemens communication settings, the option "Remote basis and remote 
OPC-communication (UA and COM)" should be manually activated. It is recommended to 
deactivate this option after the online determination.

If these conditions are not met, the inventory data of switches is determined offline.
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Note
Inventory data of field devices
Requirements:
• SIMATIC PDM (as of V8.0) is installed on the engineering station.

Note the section "Preface; Table 2-1 Overview of the most important changes (Page 14)".
• The field devices are configured using SIMATIC PDM in the PCS 7 project.
• The Management Console is able to access the SIMATIC PDM data.
The Management Console only determines the data of field devices that is relevant for the 
inventorying. 
• In a system where field devices are configured, to get the complete online inventory data 

install PDM and inventory data must first be determined with PDM. 
• The inventory data for redundant field devices is also determined with PDM.
• The inventory data of the field devices is always determined from the project. 
• The online display does not determine data from field devices that are in process mode, so 

that a load is not placed on communication with the automation system and/or with the 
field devices. 

• If inventory data from field devices is determined, only the following information about the 
field device is available:
– Plant designation (HID/TAG)
– Description (if available)
– Device type
– Firmware version
– Hardware version
– Article number / name
– Message (if available)

Note
Inventory data of CP device types
The following inventory data of a PCS 7 project on an engineering station can be determined for 
CP device types:
• IP and MAC address for CP16x3
• IP and MAC address for CP443-1

Note
Interface module shown multiple times
If the "Configuration via PDM" option is activated in the "General" tab for an interface module in 
HW Config, this interface module is shown multiple times in the plant view:
• "Configuration via PDM" option not activated (default)

– The interface module is shown with lower-level field devices on the automation system.
• "Configuration via PDM" option activated 

– The interface module is shown with lower-level field devices on the automation system.
– For field devices, the interface module is shown with lower-level field devices.
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Note
Inventory data of Process objects
The following inventory data of a PCS 7 project on an engineering station can be determined:
• Process Object count
• System ID (when available)

Procedure
1. Select the object for which you want to determine inventory data.

– Multiproject
– Project
Select the object for which you want to determine station data:
– Automation System

2. Select the Determine inventory data/Determine station data command in the shortcut 
menu for the object.
The "Determine inventory data" dialog window opens.

3. Read the information displayed on the "Determine inventory data (1/2) – Condition for 
determining inventory data" dialog window and select "I have made sure that no changes will 
be made to PCS 7 projects" to continue with determining inventory data.

4. Select one of the options in "Determine inventory data (2/2) – Specify the data source" dialog 
window:

Options Meaning
"Determine inventory data from configuration da‐
ta (offline)" check box (default setting)

The data is determined based on the PCS 7 project 
available on the engineering station.

"Determine inventory data from device data (on‐
line/PDM)" check box

The data is obtained from the PCS 7 plant includ‐
ing the field devices.

Note the following:
NOTICE
Functions of the engineering station are disabled
While inventory data is being determined, the SIMATIC Management Console disables the 
functions on the engineering station that are required for processing the PCS 7 project.
Make sure that the PCS 7 project does not need to be processed. Actions in SIMATIC 
manager, HW Config and NetPro are disabled.
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5. Click "Finish".
6. If "Determine inventory data from configuration data (offline)" as the data source has been 

chosen, the below dialog box is displayed. Select "Yes" to continue.
Note
While determining inventory data from configuration data (offline), it overwrites the existing 
online inventory plant data. Select "Determine inventory data from device data (online/
PDM)" to view the updated online plant data. 
The inventory data is determined. 
NOTICE
Inventory data is not determined
Please note that inventory data is not determined when the Management Console is ended 
during determination of inventory data.

Note
Progress display
The duration of the process depends on the number and availability of the plant components.
The progress of actions is indicated:
• The symbol "Action running" is displayed for the status of a computer during an action. 
• The symbol "Action running" is displayed for a group while actions are running for a 

computer. 
Communication errors are only displayed directly on the computer.

Note
Module properties in the plant view
For modules, the configured properties can be found in the "Inventory data" tab. Therefore, it is 
possible that the displayed properties may differ for the same modules.

Result
After the inventory data was successfully determined, it is shown in the detail view.
Detailed information is displayed within the group at the computer symbol.
Information on the symbols is available in the section "Symbols in the plant view (Page 50)".
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Canceling determination of inventory data
If the function "Determine inventory data" is being executed in the plant view, the command 
"Cancel determination of inventory data" can be selected from the shortcut menu.

Note
Data obtained
Data already obtained is discarded.

Additional information
• Section "Exporting inventory data in the plant view (Page 111)"
• Section "Determining the cause (Page 123)"
• Section "Determine inventory data" not executed (Page 128)"
• Section "External components" (Page 148)

5.6.3.5 Exporting inventory data in the plant view
The Management Console exports the inventory data of objects in the plant view automatically 
after successful determination of inventory data. Export is possible for the following base 
objects:
• Multiproject
• Project

Exported data
The following data is exported depending on the selected basic object:
• The determined inventory data for the selected base object is exported.
• Links to the Internet are provided for additional information about Siemens products.
• Export inventory data to an XML file using "Project inventory data export..." feature.

Requirement
• The inventory data for the basic object has been determined.
• For additional information refer "Determining inventory data in the plant view (Page 106)".

Operator control
5.6 Determine inventory data

SIMATIC Management Console (V9.1 SP1)
Operating Manual, 09/2021, A5E50318373-AB 111



Procedure
Export the information shown in the details area to a file.
1. Select the basic object and choose one of the following actions:

– Select the Export inventory data command in the shortcut menu
– In the toolbar, click the "Export inventory data" button.
– Click the "..." button:

The "Export inventory data" dialog window opens.
- Select the folder in which the file is to be saved.
- Change the file name if required.

2. Click "OK".
The information is exported.

The file name of the export inventory data file is displayed in the format: <default folder 
path>_<file name>_<time stamp>.

Note
Location path for the export inventory data can be specified in the "Inventory Export" tab. For 
more information see, "Settings...". This setting is applicable only for automatically generated 
export inventory data files.
The file name of the exported inventory data determined from configuration data and device 
data are displayed in the format: <configuration data>_<Projectname>_<date and time> and 
<Online device data>_<projectname>_<date and time>.

Opening exported inventory data
The exported inventory data can be opened for further use:
The recommended program is:
• XLSX file: Microsoft EXCEL
Export report contains links to the Internet
Internet links for Siemens products can be found in the export report of inventory data from the 
plant view. If the computer is connected to the Internet, more information about each product 
can be found via these links. The information is determined based on the article number of the 
product.

Additional information
Section "Saving information in files (Page 128)"
Section "Identifying errors (Page 123)"
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5.6.4 Determining information for computers

Details area - Inventory data
If a computer is selected in the project view, data on the selected computer is displayed in the 
details area in the "Network view" tab.

Actions for computer
• Section "Determining inventory data in the network view (Page 101)"
• Section "Exporting inventory data in the network view (Page 102)"

5.6.5 Filter for inventory data

5.6.5.1 "Inventory data profile wizard" overview
The Management Console allows the user to compare ACTUAL device configurations with saved 
device configurations. 
As a filter for the comparison, apply inventory data profiles that is created with the inventory data 
profile wizard.

Inventory data profile
An inventory data profile is a configurable filter for inventory data in the Management Console. 
Several parameter sets can be created per inventory data profile. When an inventory data profile 
is applied to the inventory data of a view of the Management Console, the result is automatically 
exported to an XLSX file. 
Application examples: 
• Comparing determined inventory data with an inventory data profile (software and 

hardware information).
• Determining data of all CPUs of a PCS 7 plant in preparation for the firmware update.
• Determining all computers on which a specific operating system is installed.
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Basis for an inventory data profile
• Determined inventory data is the basis for the inventory data profile:

– Specific inventory data is available on the Management Console. This inventory data has 
been determined in the required view. For additional information refer  "Determine 
inventory data (Page 98)".

– The function "Determine inventory data" has been successfully completed for the view-
specific object:

View Object
Network view Computer or network
Plant view PCS 7 project of the associated engineering station

• Known data is the basis for the inventory data profile (e.g., article number of a device)

Actions in the "Inventory data profile wizard" dialog
rCeate inventory data profiles in the "Inventory data profile wizard" dialog.
The "Inventory data profile wizard" includes the following dialogs:
1. Select view and action (Page 114)
2. Create/change inventory data profile (Page 115)

The following actions are possible:
– Create parameter set
– Change parameter set
– Delete parameter set
– Import parameter set

3. Save and/or export inventory data profile (Page 119)

Apply inventory data profile
Inventory data profiles can be applied to inventory data of a selected view. The following actions 
are possible:
• Apply inventory data profile to inventory data from the network view
• Apply inventory data profile to inventory data from the plant view
For additional information refer "Apply inventory data profile... (Page 119)". 

5.6.5.2 Dialog "Inventory data profile wizard (1/3) - Select view and action"
The Management Console allows you to compare ACTUAL device configurations with saved 
device configurations.
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Creating/loading/deleting the inventory data profile
1. Select the menu command Options > Inventory data profile wizard... .

The "Inventory data profile wizard 1/3 - Select view and action" dialog opens.
2. Select the view containing the determined inventory data on the Management Console:

– Network view
– Plant view

Note
Selected view
• If the current inventory data has been determined in the network view, an inventory data 

profile cannot be created for data of the plant view.
• To create an inventory data profile based on known data (without determined inventory 

data), the view with the required inventory data is to be found.

3. Select from the following options:
– Create new inventory data profile
– Load inventory data profile (e.g. to adapt this inventory data profile)

The view-specific inventory data profiles can be found in the drop-down list that opens.
– Delete inventory data profile
– Import inventory data from XML file (e.g. to adapt this inventory data profile)

Inventory data profiles created by an export can be imported and edited. 
4. Click "Next".

The "Inventory data profile wizard (2/3) - Create/change inventory data profile" dialog opens.

5.6.5.3 Dialog "Inventory data profile wizard (2/3) - Create/change inventory data profile"
This dialog is in the inventory data profile wizard.

Inventory data profile
An inventory data profile is a configurable filter for inventory data in the Management Console. 
Several parameter sets can be created per inventory data profile. When an inventory data profile 
is apllied to the inventory data of a view of the Management Console, the result is automatically 
exported to an XLSX file. 
Application examples: 
• Comparing determined inventory data with an inventory data profile (software and 

hardware information).
• Determining data of all CPUs of a PCS 7 plant in preparation for the firmware update.
• Determining all computers on which a specific operating system is installed.
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"Name for the inventory data profile" input box 
• If "Create new inventory data profile" option is chosen, a name must be entered in the input 

box "Name for the inventory data profile".

Note
Naming conventions
The following special characters are allowed in the name: Space, underscore, dash, period.

• If "Load inventory data profile" option is chosen, an existing inventory data profile must be 
selected in the dropdown list. 

• If "Import inventory data profile from XML file" option is chosen, an inventory data profile file 
must be selected at its storage location using the "..." button. 
File type: XML file
An inventory profile file can be recognised by its name: 
InventoryDataProfile_SIMATICSoftware_<... Version>.xml
After the inventory data profile file has been selected, the name of the imported filter is 
displayed: SIMATICSoftware_<... Version> (e.g. SIMATICSoftware_<...> V8.2)

Note
Inventory data profile file in the PCS 7 media
You can find a file for pre-defined, version-specific filters:
• Additional Products/SMMC
Copy this file to the PC and make it available as a filter using the "Import inventory data profile" 
option.

Parameter set
1. Adapt the parameter set in the table. The following actions are possible:

– Create parameter set
– Change parameter set
– Delete parameter set
Execute the following actions:
Use the examples in the table below for orientation. 

Table 5-6 Example 1: Simple parameter set - Determine "Installed SIMATIC software"
Logic op‐
eration

Category Subcategory Field Operand Value

AND / OR Category (1) Subcategory (1) Field (1) Operand (1) Value (1)
 Installed software SIMATIC software Name not equal to ?
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Table 5-7 Example 2: Simple parameter set - Determine "Installed SIMATIC BATCH software"
Logic op‐
eration

Category Subcategory Field Operand Value

Example 2: Simple parameter set - Determine "Installed SIMATIC BATCH software"
 Category (1) Subcategory (1) Field (1) Operand (1) Value (1)
 Installed software SIMATIC software Name Includes BATCH

Table 5-8 Example 3: Extended parameter set: Determine "Installed SIMATIC BATCH software prior to version 8.2"
Logic op‐
eration

Category Subcategory Field Operand Value

AND / OR Category (1) Subcategory (1) Field (1) Operand (1) Value (1)
 Installed software SIMATIC software Name Includes BATCH
 Category (2) Subcategory (2) Field (2) Operand (2) Value (2)

AND Installed software SIMATIC software Version older than 8.2.0.0

Table 5-9 Example 4: Extended parameter set: Determine automation systems in which certain modules are combined, e.g. 
"CPU 410-5H" and "CP 443-1 Advanced".

Logic op‐
eration

Category Subcategory Field Operand Value

AND / OR Category (1) Subcategory (1) Field (1) Operand (1) Value (1)
 Plant inventory 

data
CPU Device type Includes CPU 410-5H

 Category (2) Subcategory (2) Field (2) Operand (2) Value (2)
AND Plant inventory 

data
CP Device type Includes CP 443-1

Note
Drop-down list "AND / OR" (logic operation) 
If a logic function is selected in the "AND / OR" column in the drop-down list, parameter set (1) 
is expanded by 5 parameters (2). The two lines of the parameter set can be linked with the 
selected logical function.

Operator control
5.6 Determine inventory data

SIMATIC Management Console (V9.1 SP1)
Operating Manual, 09/2021, A5E50318373-AB 117



Note
Parameters and categories
The possible parameters depend on both the view in which the inventory data was determined 
on the Management Console, as well as the categories included in the available inventory data:
• Inventory data (from the network view or from the plant view)
• Installed SIMATIC software 
• Installed third-party software 

– Installed version of Microsoft .NET Framework  with version number (Select Inventory 
data > Installed software > Installed third-party software).

– Microsoft patches with Product name, Publisher, KB, installation date, and title.
– Installed security software with manufacturer, product, version (Symantec Endpoint 

Protection, McAfee Agent, McAfee Endpoint Protection Suite, Trend Micro OfficeScan 
Corporate Edition V11.0).

• Licenses
• From plant inventory data (configuration information)

Note
Value for inventory data profile based on known data 
Make sure to find the exact value to filter the inventory data. Alternatively, select the PCS 7 
installation packages to filter the inventory data.
Example:
If the installed software is determined, insert the "Release version" in the "Value" field. 
The "Versions" drop-down list offers values that have not been filtered for the product (SIMATIC 
BATCH). The contained values represent the technical versions of the installed software 
products.
Recommendation:
Determine the inventory data before you create specific inventory data profiles to determine the 
required data more easily.

Create/modify/delete parameter sets
The selection of the parameters of a parameter set takes place according to the information 
determined with the "Determine inventory data" function. 
• The combinations within a parameter set result from the selection in the "Category" and 

"Subcategory" drop-down lists.
• Select the Column, Operand and Value settings to limit the search.
Several parameter sets can be created for an inventory data profile. All parameter sets contained 
in an inventory data profile are combined by the "OR" logic operation.
Creating a parameter set in the profile table
• Adapt the lines of the parameter set.
• Then click "Add".
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Changing a parameter set in the profile table
• Double-click a row in the profile table. 
• Adapt the lines of the parameter set.
• Click "Change". This applies the change to the parameter set.
Removing a parameter set from the profile table
• Select a row in the profile table.
• Click the "Remove" button.

Finish settings
Click "Next".
The "Inventory data profile wizard (3/3) - Save inventory data profile" dialog window opens.

5.6.5.4 Dialog box "Inventory data profile wizard (3/3) - Save inventory data profile"
This dialog is in the inventory data profile wizard.

Categories in the export file (XLSX file)
The categories configured as filters in the inventory data profile are displayed.

Save / export inventory data profile
1. Select the option boxes in the "Categories in the export file" area for the desired inventory 

data.
2. Make the settings for the profile:

– "Save" check box
The inventory data profile is saved in the Management Console.

– "Export" check box
Click "..." to select the folder where the inventory data profile is to be exported.
The inventory data profile is stored as an XML file in the file system.

3. Click "Finish".

5.6.5.5 Apply inventory data profile...
The Management Console allows users to compare ACTUAL device configurations with saved 
device configurations.
Apply an inventory data profile to the determined inventory data of a selected view for the 
comparison. The following actions are possible:
• Apply inventory data profile to inventory data from the network view 
• Apply inventory data profile to inventory data from the plant view 
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Applying an available inventory data profile (XML file)
When an inventory data profile is available in an XML file, you must import the inventory data 
profile from the XML file to the Management Console prior to the application.
For additional information refer "How to import an inventory data profile from an XML file 
(Page 120)".

Requirements
• The function "Determine inventory data" has been successfully completed for the view-

specific object. The inventory data has been determined in the required view (network view 
or plant view). For additional information refer:
– Section "Determining inventory data in the network view (Page 101)"
– Section "Determining inventory data in the plant view (Page 106)"

• The required inventory data profile has been created in the Management Console.
For additional information refer ""Inventory data profile wizard" overview (Page 113)".

Procedure
1. Select the desired object in the tree structure.

– Network view: Network, group, computer
– Plant view: Multiproject, subproject

2. Select the "Apply inventory data profile" command in the shortcut menu.
The "Apply inventory data profile" dialog box opens.

3. Select the desired inventory data profile from the "Inventory data profile" drop-down list.
4. Click "..." to select the folder in which the export file is to be saved.

For additional information refer "Saving information in files (Page 128)".
5. Click "Apply". 

The inventory data is filtered and the results are saved in the export file.

Note
Message
If no matches are found for the created inventory data profile, you receive a message.

Additional information
Refer Comparing SIMATIC hardware versions (Page 122)

5.6.5.6 How to import an inventory data profile from an XML file
The function "Import inventory data profile" is best suited as preparation for the comparison of 
operator's own inventory data with other inventory data. 
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Requirements
• An inventory data profile was exported as XML file.

For additional information refer "Dialog box "Inventory data profile wizard (3/3) - Save 
inventory data profile" (Page 119)".

• Access to the XML file is possible in the Management Console.

Applying an available inventory data profile
• Import the provided inventory data profile from the XML file.

For additional information refer "Dialog "Inventory data profile wizard (1/3) - Select view and 
action" (Page 114)"; "Import inventory data profile from XML file" option
The imported inventory data profile is available in the inventory of the inventory data 
profiles of the Management Console.

• In the next step, apply the inventory data profile to the operator inventory data.
For additional information refer "Apply inventory data profile... (Page 119)".

5.6.6 Comparing SIMATIC software versions 

Compare SIMATIC software versions overview 
Compare SIMATIC software version is a feature which allows the users to compare the version 
of the installed software with the latest version of the software as updated in the recent PCS 7 
bundle.The comparison excel sheet generated through this feature displays the difference 
between the two versions of the software. This allows the user to view the list of software which 
is different from the version specified in the version definition file (XML) and also provides the 
link to update the software as defined in the version definition file. 

Requirements
• The function Software Compare is enabled only for licensed computers. 
• The version reference file is provided in the PCS 7 website.

Procedure
To compare software versions of installed software to the latest version of software:
1. Open the Network view in the Management Console.
2. Select a network, computer or a group of assigned computers which are to be compared. 
3. In the context menu, select the command "Compare SIMATIC software versions...".
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4. On the "Compare SIMATIC software version" window, click the "..." button to select the 
version definition file. 
Note
• The version reference file which consists of the standard versions of the software is 

provided with the PCS 7 bundle in .XML format. This XML file must be selected for 
software compare.

• The version reference file for the latest PCS 7 software can be downloaded from the PCS 
7 website. This XML file must be selected for software compare."

5. Select the cover page for the software compare file from the drop-down list. 
6. Click the "..." to select the storage path for the software version compare export excel sheet. 

Note
The name of software version compare export excel sheet is saved in the format: 
ComparedVersion_<date and time>.xlsx file.

The software version compare is successfully completed. 
In the ComparedVersion_<date and time>.xlsx file, the General Project Information and 
Comparison of Installed SIMATIC SW can be viewed. The Comparison Installed SIMATIC SW sheet 
lists the Computer name, Product name, Installed version, Latest version of the software and if 
there is a difference between the versions.
In the version reference file, certain software is listed as Ignored Profiles. The software listed 
under Ignored Profiles are not displayed in the compared version excel file.

Note
After the software version compare is successfully completed, status of the software compare 
can be viewed in the "Alarms" tab.
The updated and outdated software can be viewed in the " Installed SIMATIC software" tab. Also, 
the software details of the Ignored Profiles can be viewed on the "Installed SIMATIC software" 
tab. 
For additional information see "Inventory data" tab (Page 56)

5.6.7 Comparing SIMATIC hardware versions
 The SIMATIC Management Console provides a way to compare the existing modules in a plant 
project/multiproject with the latest hardware and firmware versions of the modules. An excel 
report is generated consisting of the latest hardware and/or firmware versions for the outdated 
modules. The same is visible in the SMMC "Plant view" in the project/multiproject level.
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Requirements
• SIMATIC Management console V9.1.1, latest update.
• A plant is added and project inventory data is determined.
• Download the XML reference file (Item 6) from here (https://support.industry.siemens.com/

cs/ww/en/view/109794407). 

Procedure to compare hardware versions
To compare the versions of the installed hardware and the latest hardware available: 
1. Open the Plant view in the Management Console. 

Refer Add Plant  (Page 104)for more information.
2. Click the "..." to browse the storage path of the downloaded XML reference file. 
3. Select "Compare SIMATIC hardware versions…" option from the context menu in project/

multiproject level. 
4. Select the cover page for the hardware compare file from the drop-down list.
5. Click the "..." to browse the storage path for the hardware version compare export excel sheet.
6. Click "OK". 

The confirmation window when online device data is not present is displayed.
7. Click "Yes". 

The output of the hardware comparison is visible on the tool also can be exported as an excel 
sheet.

5.7 Identifying errors

5.7.1 Determining the cause
If an unexpected behavior is observed in the SIMATIC Management Console, following points 
are to be checked:
• SIMATIC Management Agent not started (Page 124)
• Management Console cannot be operated (Page 124)
• Computers are not recognized
• Computer is not recognized by the Management Console (Page 124)
• Software cannot be installed (Page 125)
• Setup program is not found (Page 126)
• Setup package is not run (Page 126)
• Function cannot be operated (Page 128)
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• Requirement for the "Determine inventory data" function (Page 100)
• "Determine inventory data" not executed (Page 128)

5.7.2 SIMATIC Management Agent not started
The Management Console cannot be operated.

Question Procedure
Have you installed a new Management Console? Activate the "SIMATIC Management Agent" service is on the computer 

(see chapter "Installing SIMATIC Management Agent (Page 31)").

5.7.3 Management Console cannot be operated
The Management Console cannot be operated.
Possible messages:
• The action cannot be executed. The number of computers exceeds the number of available 

license keys. For this reason, computers are to be removed from the assignment.
• No license exists for the SIMATIC Management Agent.

Question Procedure
Are sufficient license keys available for the "SIMATIC 
Management Agent" service on the computer with the 
Management Console?

Check the number of assigned target computers and available license 
keys on the computer of the Management Console.
Perform one of the following actions so that the Management Console 
can be operated: 
• Install additional license keys for the "SIMATIC Management 

Agent" service on the computer with the Management Console.
• Remove target computers from the assignment to the Manage‐

ment Console.

5.7.4 Computer is not recognized by the Management Console
Check the following:

Question Procedure
Has the computer with the Management Console been 
replaced?

Check whether the computer is assigned to another Management 
Console.

Has the computer been moved from workgroup to do‐
main or are there any changes in the domain?

Restart Management Console computer.

Is there a network connection to the computers? Open "cmd" using the search box in the  start menu.
In the DOS window, enter the ping <IP address>

Is the computer prepared for access via the Manage‐
ment Console?

Check whether the "SIMATIC Management Agent" service is installed 
and activated/started.
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Question Procedure
Is the valid pre-shared key entered on the target com‐
puter?

Check the pre-shared key.

Is the IP address or Windows hostname changed in the 
SIMATIC Management Agent target computer?

If the IP address or hostname of a target computer which was already 
assigned to Management Console is changed, then to reconnect with 
the Management Console: 
1. Disable assignment of the target computer. 
2. Reboot the Management Console.
3. Assign the target computer again.
 

5.7.5 Software cannot be installed
Check the following:

Question Procedure
Has the computer been assigned to the Management 
Console?

Check the Management Console to see which icon is displayed for 
target computers. 

Is the computer prepared for access via the Manage‐
ment Console?

Check whether the "SIMATIC Management Agent" service is installed 
and activated/started.

Is the Management Agent on the target computer up 
to date?

Check the Management Console to see which icon is displayed for 
target computers. 

Is the current user authorized to carry out the action? Check the permissions in the user management of the domain or lo‐
cally on the computers.

Was the Management Console restored from a backup? If the Management Console was restored from a backup on a newly 
installed or a different computer, software packages in the backup 
must be created again.

5.7.6 Setup cannot be started
If you see the message "Setup cannot be started ..." on the console, check the following:

Question Procedure
Is another setup process (Example: A Security soft‐
ware) running on the target computer?

Check if another setup process (Example: A Security software) is run‐
ning on the target computer. 
• If no other setup process is running, reboot the target computer. 
• If another setup process (Example: A Security software) is running, 

wait until it is completed and then reboot the target computer.
Does the user on the target computer have permission 
to access the target system?

Check the following on the target computer:
• Is the user account set up?
• Is the user account active?
• Have the administrative permissions been entered?

Does the user have administrative rights on the target 
system?

Increase the level of the user's permissions.
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Question Procedure
Does the user have permission to access the share lo‐
cation on which the software is stored?

Allow access to the target system.

Are the installation requirements on the target system 
met?

Ensure that the installation requirements are met.

5.7.7 Unable to create setup package

 
Check the following:

Question Procedure 
Unable to create setup packages Possible Cause:

• Low bandwidth (less than 256 Kbit/s) of the connection to 
the storage of the setup files. Check the strength of the 
connection.

5.7.8 Setup program is not found
Check the following:

Question Procedure
Is the setup file available in the storage location? Check the software storage location (network path and name of the 

setup file).

5.7.9 Setup package is not running
Check the following:

Question Procedure
Are the necessary software packages available? Check the software storage location (network path and name of the 

setup file).
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5.7.10 Computer is not ready for installation
Check the following:

Question Procedure
Are processes run‐
ning on the instal‐
lation computer 
that may prevent 
installation of the 
software packages?

Check the redundancy status.
Pay attention to possible effects on process mode (e.g. if redundancy switchover is required).
Note: Redundancy status prevents software update
In process mode, the servers of a redundant server pair can only be installed one after the other for 
availability reasons (mutual exclusion of readiness for installation). 
• When a server pair is in process mode, simultaneous update of both computers using the Manage‐

ment Console is blocked in the Management Console.
• The redundant partner is not available. 
• The software cannot be installed on the current master because the redundancy switchover is not 

possible.
If PCS 7 software packages are being updated prior to version 8.1 on computers on which SIMATIC BATCH 
or SIMATIC Route Control is installed:
Check whether process mode is activated. 
Note: Process mode prevents additional actions
To update these software packages while using the SIMATIC Management Console, you must ensure that 
process mode of all software packages is ended for these PC stations.

Setup cannot be 
installed?

Check whether the setup is suitable for installation with the Management Console.
The software update using the Management Console cannot be performed for some software packages 
of PCS 7. 
The following software packages can only be distributed as new installations with the SIMATIC Manage‐
ment Console:
• Process Historian
• Information Server
• OpenPCS 7 (update of the "SIMATIC Management Agent" service possible as of installed version 8.1).
• Web Option for OS 

(Web Client or Web Diagnostic Client: Updating the "SIMATIC Management Agent" service is possible 
as of installed version 8.1).

These software packages need to be manually installed for a software update.
Is the installation 
computer a server?

Make sure that the server is not in the "fault" state.

Have you checked 
the following cau‐
ses?

• Is the computer prepared?
– Management Console cannot be operated (Page 124)
– Setup program is not found (Page 126)
– Setup package is not running (Page 126)

• Is the computer available?
– Computer is not recognized by the Management Console (Page 124)
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5.7.11 Function cannot be operated
Check the following:

Question Procedure
Is the current user entered in the "SIMATIC Manage‐
ment Users" user group on the Management Console 
computer and the target computer?

Check the permissions in the user management of the domain or lo‐
cally on the computers.

Is the inoperable function the setup management? Check that all installations are complete. For additional information 
refer "Running installations... (Page 137)".

5.7.12 "Determine inventory data" not executed
Check the following:

Question Procedure
Are user-specific names used in the project 
with characters that are not permitted?

Check the user-specific names in the project. 
For additional information refer "Requirement for the "Determine inventory 
data" function (Page 100)"

Should the inventory data of switches be de‐
termined online?

Check whether the conditions for determining online data have been met:
• A user is logged on to the engineering station. 
• The user logged on to the engineering station is a member of the local 

Windows group "SIMATIC NET".
Should the inventory data of field devices be 
determined online?

The online display does not include the determination of field devices that are 
in process mode. This means that a load is not placed on communication to the 
automation system or to the field devices.  

Should the inventory data of field devices be 
determined offline?

Check whether the conditions for determining data of field devices have been 
met:
• SIMATIC PDM (as of V8.0) is installed on the engineering station.
• The field devices are configured using SIMATIC PDM in the PCS 7 project.
• The Management Console is able to access the SIMATIC PDM data.

5.8 Saving information in files
Using the Management Console, you can export information in files.
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Information
Information Preparation Procedure File format
Event log None 1. Menu command File > Event display 

(Page 60)
2. "Export" button
3. Select path and enter file name
4. Save

• CSV

Alarm protocol None 1. Select the shortcut menu command Export 
in the message list.

2. Select path and enter file name
3. Save

• CSV

Inventory data Menu command Deter‐
mine inventory data

1. Select object
2. "Export inventory data" shortcut menu com‐

mand Exporting inventory data in the net‐
work view (Page 102) or button 

• XLSX

Inventory data filtered 
using an inventory da‐
ta profile

Menu command:
• Determine inventory 

data
• Inventory data pro‐

file wizard
• Apply inventory data 

profile

1. Select object (in the view in which the inven‐
tory data was obtained)

2. Shortcut menu command Apply inventory 
data profile... (Page 119)

3. Select inventory data profile
4. Select path and enter file name
5. Apply

• XLSX

Installation report Menu command
Create installation re‐
port

1. Menu command Options > Create installa‐
tion report... (Page 94)

2. Select a reporting period 
3. Select path and enter file name
4. Save

• PDF

License report None 1. Menu command Options >  Create license 
report... (Page 150)

2. Select path and enter file name
3. Save
4. Forward file to Siemens contact person

• XLSX

Project inventory data 
export

• "Add plant" overview 
(Page 104)

• "Dialog window "Add 
plant (1/2) Specify En‐
gineering Station" 
(Page 105)

• "Dialog box "Add plant 
(2/2) – Select projects" 
(Page 105)

• "Determining invento‐
ry data in the plant 
view" (Page 106)

1. Select "Options> Project inventory data ex‐
port..."

2. Select the project to export data in XML for‐
mat.

3. Select the cover page for your project from 
the "Please select the cover page" drop down 
list. Select the storage location for your XML 
file from the "Please select the storage loca‐
tion" button and click "OK".

• XML
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Note
Visualization of the files
• To read PDF files, a PDF reader that is compatible with PDF 1.7 (ISO32000-1:2008 PDF) is 

required.
• We recommend Microsoft EXCEL for editing the XLSX and CSV files.
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Menus and dialog boxes 6
6.1 "File" menu

6.1.1 Back up data...
Following data can be backed up into a file from the SIMATIC Management Console :
• Inventory data of Plants and all the computers that are assigned to the SIMATIC Management 

console.
• All the events that were logged in by the SIMATIC Management console.
• Setup management related configurations
• All the settings configured under "Options" > "Settings".
• Language settings.
 Using the backup file, the data can be restored on any computer on which the Management 
Console is installed.

Note
Pre-shared key
The pre-shared key valid at the time of the backup is not saved. To restore communication to the 
connected computers, the currently valid pre-shared key must be known.

Note
Alarms 
Alarms recorded by the SIMATIC Management Console cannot be backed up.

Procedure
1. Select the menu command File > Back up data.

The "Back up / recover SIMATIC Management database" dialog opens.
2. Select the path and file name for the backup file.
3. Click "OK".
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6.1.2 Restore data...
Using the backup file, following data can be restored on any computer on which the SIMATIC 
Management Console is installed:
• Inventory data of Plants and all the computers that are assigned to the SIMATIC Management 

console.
• All the events that were logged in by the SIMATIC Management console.
• Setup management related configurations
• All the settings configured under "Options" > "Settings".
• Language settings

Note
Restoring data from a Management Console with assigned computers
• First use the "Disable console assignment (Page 133)" menu command before restoring the 

data.
• The valid pre-shared key is not included in the backup. 

To restore communication to the connected computers, the currently valid pre-shared key 
must be entered.

Procedure
1. Select the menu command File > Restore data.

The "Back up / recover SIMATIC Management database" dialog opens.
2. Select the path and file name of the back up file.
3. Click "OK".

Note
Consider the following factors while restoring a back up file in the SIMATIC Management Console 
computer:
• Data present in the SIMATIC Management Console are overridden with data in the back up 

file.
• The overridden data cannot be retrieved unless a back up of the data is taken before restoring 

the back up file.

6.1.3 Exit
Exits the Management Console dialog box.    
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6.2 "Edit" menu

6.2.1 Create group
This menu command is used to create groups in the network view.

Version 1:
1. Select the network object in the network view.
2. Select the menu command Create group in the shortcut menu.

Version 2:
1. Select the network object in the network view.
2. Select the menu command Edit > Create group.

Result
A folder for a group with the name "New group" is created in the network view.
Recommendation: Rename the new group.

6.2.2 Delete group
This menu command is used to delete groups from the network view structures.

Procedure
1. Select the group in the network view.
2. Select the menu command Edit > Delete group.

The computers in the previously selected group are moved to the "Non-assigned computers" 
folder.
Note
The menu command "Delete group" cannot be used for the "Unassigned computers" group.

6.2.3 Disable console assignment
This menu command is used to cancel the console assignment to all computers in the network. 
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The console assignment of the Management Console to all computers in the network must be 
canceled if the Management Console is to be switched to another computer. 

Note
All data of the Management Console is deleted.

Requirements   
• The user is logged on as the administrator of the Management Console (see section 

"Managing rights (Page 25)").
• The Management Console is started.

Procedure
1. Select the menu command Edit > Disable console assignment.

A note on canceling the console assignment is displayed.
2. Click "OK".

The console assignment is canceled.

Result
Management Console can be started on another computer.

Additional information
Section "Adding computers (Page 63)"

6.2.4 Update network view
This menu command is used to update the displayed information.
Called via keyboard: <F5>

Note
This menu command can only be used on the objects of the network view.
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6.3 "View" menu

6.3.1 Network view
This menu command is available when the plant view is displayed in the Management Console.

Calling functions via the shortcut menu
The table below sets out functions which can be run for objects in the network view using the 
shortcut menu. 
Information on the availability of this function can be found in the relevant section of this 
documentation. 

Object Group functions Computer-specific functions Other functions
Network nodes • Create group 

(Page 133)
• Adding computers 

(Page 63)
• Canceling the assignment 

of a computer (Page 65)

• Reset status (Page 65)
• Updating the SMAgent
• Determining inventory data in the 

network view (Page 101)
• Exporting inventory data in the 

network view (Page 102)
• Apply inventory data profile... 

(Page 119)
Group • Create group 

(Page 133)
• Create group 

(Page 133)
• Delete group 

(Page 133)

• Adding computers 
(Page 63)

• Canceling the assignment 
of a computer (Page 65)

 

• Reset status (Page 65)
• Updating the SMAgent
• Determining inventory data in the 

network view (Page 101)
• Exporting inventory data in the 

network view (Page 102)
• Apply inventory data profile... 

(Page 119)
• Installing SIMATIC software 

(Page 85)
• Updating SIMATIC software 

(Page 88)
• Create installation report... 

(Page 94)
• Microsoft Software Updates instal‐

lation (Page 95)
• Comparing SIMATIC software ver‐

sions  (Page 121)

Menus and dialog boxes
6.3 "View" menu

SIMATIC Management Console (V9.1 SP1)
Operating Manual, 09/2021, A5E50318373-AB 135



Object Group functions Computer-specific functions Other functions
Assigned computers - • Adding computers 

(Page 63)
• Canceling the assignment 

of a computer (Page 65)

• Reset status (Page 65)
• Updating the SMAgent
• Determining inventory data in the 

network view (Page 101)
• Exporting inventory data in the 

network view (Page 102)
• Apply inventory data profile... 

(Page 119)
• Installing SIMATIC software 

(Page 85)
• Updating SIMATIC software 

(Page 88)
• Create installation report... 

(Page 94)
• Microsoft Software Updates instal‐

lation (Page 95)
• Comparing SIMATIC software ver‐

sions  (Page 121)
Non-assigned comput‐
ers

- • Assigning computers 
(Page 62)

-

-: Function not available

Reset status
The "Reset status" function resets the status displayed by the SIMATIC Management Console.
Application example:
An already completed action is displayed with "Action is running". This means that additional 
actions are blocked on this computer.

6.3.2 Plant view
This menu command is available when the network view is displayed in the Management 
Console.
Select the plant view to use the Management Console to determine the inventory data of PCS 7 
plants.

Note
Following installation of the Management Console
The plant view only shows the "Plants" node. 
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Preparing the plant view
The following steps must be taken to display information about objects of the PCS 7 plants in the 
plant view:
1. Add the engineering stations to the Management Console.

For more information refer "Settings... (Page 140)".
2. The PCS 7 projects of the plants are available. 

For more information refer "Dialog box "Add plant (2/2) - Select projects" (Page 105)".

Calling functions via the shortcut menu
The table below sets out functions which can be run for objects in the plant view using the 
shortcut menu.
Requirements:
• One of the following objects (or a lower-level object) is selected in the tree view.
• The inventory data has been determined for the object or a higher-level project.

Object Determine inventory 
data

Export inventory data Remove <Object> Reset status

Multiproject X X X -
Subproject of a Multi‐
project

X X - -

Single project X X X -
Engineering station - - X X

X: Function can be executed
-: Not possible 

Additional information
• Section "Starting the Management Console (Page 39)"

6.3.3 Event display...
This menu command opens the "Event viewer" dialog box. 

6.3.4 Running installations...
This menu command can be used to check whether installations started with the Management 
Console are currently still running.
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Displaying the status of installations
Select the menu command View > Running installations.
The "Overview of running remote installations" dialog opens.
The table in the dialog shows the following information in every filled line:
• Date / Time: Start of the installation of the product shown in the "Description" column
• Computer name: Name of the computer on which the installation has started
• Event (short description): Featured setup package or setup
• Description: Displays the currently running installation step and the associated product
• User name: Name of the Windows user who started the installation of the setup package or 

the Setup program.
The update of the "SIMATIC Management Agent" service via the shortcut menu command 
"Update or repair SMAgent (Page 67)" is not displayed in the "Overview of running remote 
installations" dialog.

Table is empty?
If there is no entry in the table, all remote installations that were started with the Management 
Console are terminated when the menu is opened. For more information refer "Event display 
(Page 60)".

6.3.5 SMAgent license display...
The following information is displayed in the dialog box:
• Number of occupied licenses

The number of used "SIMATIC Management Agent" license keys shows how many computers 
are connected to the Management Console.

• Number of free licenses
The number of free "SIMATIC Management Agent" license keys shows how many additional 
computers can be connected to the Management Console.
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6.4 "Options" menu

6.4.1 Language...

Language displayed in the menus and dialog boxes 
The language displayed in the menus and dialog boxes is set as follows after installation of the 
Management Console:
• Operating system language 

If the menus and dialog boxes are available in the language of the operating system.
• English

If the menus and dialog boxes are not available in the language of the operating system.

Switching language in menus and dialog boxes 
1. Select the menu command Options > Language.
2. Select one of the available languages.
3. Click "OK".

6.4.2 Set pre-shared key...
Use the dialog box to specify the pre-shared key for the communication of computers with the 
Management Console.

Procedure
1. Pay attention to the information in the dialog box.

– To hide the entires from people around, select the check box "Hide characters when 
typing" (default setting: selected).

– Enter the new pre-shared key.
– Enter the new pre-shared key also in the "Confirm new pre-shared key" input box.

2. Click "OK".

Adapting the pre-shared key at a later time 
More information on subsequent changes to the pre-shared key on a computer with installed 
SIMATIC Management Agent in the section "How to change the pre-shared key on a computer 
at a later time  (Page 74)".
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6.4.3 Settings...
The Options > Settings command is used to specify settings for work with the Management 
Console.

"Specify Engineering Station" tab 
On the "Specify Engineering Station" tab, select the PCS 7 engineering stations where PCS 7 
projects are stored. Some information for determining the inventory data is obtained from 
project data.
Requirement
• The engineering stations are assigned using the Management Console.

For more information refer "Assigning computers (Page 62)".

Function Selection
Preparing the Manage‐
ment Console for evaluat‐
ing engineering station 
project data.

1. In the "Add ES" drop-down list, select the computer name of one or more 
engineering stations.

2. Click on the "Add" button.
The computers are added to the list "Available ES".

3. Click "OK"
Note:
Then select the PCS 7 project – or projects – from the plant view.
The license name and the process object count can also be found when 
the project is selected (Only when we determine the inventory data for 
the added plant).

 
 

"SIMATIC Management Agent Setup" tab 
Using this tab specify the network path and the name of the setup file to which the software has 
been copied for updating the "SIMATIC Management Agent" service.
Enter the network path (in UNC notation) and the name of the setup file in the "Network path and 
name of a setup file" input box.

Note
The functions of the Management Console can only be used on the computers in the network 
on which the same version of the "SIMATIC Management Agent" service is installed. 

"Web server" tab
On the "Web server" tab, select the check box to update or install software through Management 
Console on a target computer with an active runtime of the web server.
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If the check box is selected, the Management Console ends the active runtime of the web server 
and closes the projects on the target computer and then, the Management Console installs or 
updates the software on target computers.

Note
If auto-start is enabled on the target computers and in the Management Console, then after the 
installation of software the projects start automatically.

If the check box on the "Web server" tab is not selected and the runtime of the web server is 
active, the Management Console does not allow the installation of the software and a   is 
displayed in the "Status" column as displayed in the below dialog.

"Update device status" tab
In this tab, specify the cycle time for determining the device status. The Management Console 
attempts to update the required information within the specified time.

Function Possible values
Setting the cycle time (in minutes) for device status 
check
• Default value: 1 min

• 0.5
• 1
• 5
• 10
• 30
• 60

"Update network status" tab
On this tab, specify the cycle time for updating the network status. The Management Console 
attempts to update the required information within the specified time. 

Function Possible values
Setting the cycle time (in minutes) for updating the 
network status
• Default value: 5 min

• 1
• 2
• 5
• 10
• 30
• 60

"SIMATIC Batch" tab
Global settings are required for installing SIMATIC BATCH. These settings enable setups to be 
executed on the target computers without local entries.
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For additional information, please refer to the following documentation: 
• Section "Computer is not ready for installation (Page 127)"
• SIMATIC BATCH help

"Inventory Data Export" tab
On the "Inventory Data Export" tab, the location to save the automatically generated inventory 
data export files can be specified. 
The inventory data files of objects in both plant and network view are automatically exported 
and saved only in the specified location. 
The automatically generated inventory data export file of objects in a plant and network view are 
saved in the format:<Project name>_<date and time> and Inventory data_<date and time> 
respectively.
Cover page for the export inventory data file can also be chosen.

Note
When inventory data export path is not specified in the "Inventory Data Export" tab, by default 
the automatically generated inventory data export files are saved in the Libraries>Documents 
folder.

"Cover page" tab
Cover pages can be created for reports and exports with the Management Console.
The list displays the names of the configured cover pages.

Objective / Action Procedure
Add/edit cover page • Click "Add".

• Select a cover page entry in the list. Click "Edit".
Opens the dialog box "SIMATIC Management Console - Configuring cover 
page".
1. SIMATIC Management Console (1/4) - Configuring cover page 

Enter the plant-specific information in the dialog box.
2. SIMATIC Management Console (2/4) - Configuring cover page 

Enter the contact information of the plant operator in the dialog box.
3. SIMATIC Management Console (3/4) - Configuring cover page 

Enter the contact information of the contact person (Siemens) in the 
dialog box.

4. SIMATIC Management Console (4/4) - Configuring cover page
Enter a comment with up to 500 characters in the input box. This 
comment will be visible on the cover page.

Delete cover page 1. Select a cover page entry in the list.
2. Click "Delete".
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Objective / Action Procedure
Export cover page to a file 1. Select a cover page entry in the list.

2. Click "Export".
3. Select the export path.

Import cover sheet into list 1. Click "Import".
2. Select the path of the import file.

Change name of a cover page 1. Select a cover page entry in the list.
2. Click on the name. The area changes into an input area.
3. Enter a name.

"E-mail configuration" tab
This tab allows the operators to enable and configure an automated e-mail system, that sends 
out alerts to the listed operators as and when critical Windows defender events occur in any of 
the computers present in the network. The feature lets the operators configure the following e-
mail settings:
1. Check or uncheck the checkbox to enable or disable the feature.
2. List of operators to be alerted when critical events occur.
3. Outgoing SMTP server through which the e-mails are to be sent.
4. SMTP SSL/TLS port number through which the secured e-mail transmission should take place. 

In general, port 465 is used.
5. SMTP protocol comes without a native security layer. So, we recommend using an encryption 

protocol SSL (Secure Socket Layer) or TLS (Transport Layer Security).
6. "From name" to be used in the e-mail alerts. 
7. "From e-mail address" to be used in the e-mail alerts.
8. This option lets the operator do a test run of the e-mail alert system with the configured 

settings. Before sending out the test e-mail, SIMATIC Management Console verifies all the 
settings configured in the tab, and displays corresponding error messages if any of the filled-
in data does not fit in the expected standard. 

9. When enabled, the operators can provide their username and password, which is later used 
by the SMTP server to authenticate the e-mail account. When an e-mail is to be sent out by 
the SIMATIC Management Console, the given credentials are validated. If the credentials are 
valid, the e-mail will be sent to the listed recipient e-mail addresses.
Note
We highly recommend using an e-mail server that uses SMTP protocol for e-mail 
transmission.
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"Microsoft software updates" tab
This tab allows the operators to configure certain settings that would allow them to postpone 
the installation of the Microsoft software updates in the respective computers. The settings 
include- postpone duration, maximum number of postpones and the message window time-
out. For more information refer Microsoft Software Updates installation (Page 95). 
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"Software Administration" tab
This tab allows the operator to enable or disable the option "Software integrity check". This 
option can be used to check the integrity of the SIMATIC softwares (That facilitates remote 
installation of SIMATIC softwares, update of SIMATIC Softwares and update of SMAgents on the 
target computers) before deploying them. For more information refer Integrity check for PCS 7 
software  (Page 75).

Additional information
For more information refer 
• Section "Setup management... (Page 145)"
• Section "Installing SIMATIC software (Page 85)"
• Section "Setup packages (Page 83)"

6.4.4 Setup management...
Only a piece of software can be installed using the Management Console if the software is 
recognized by the Management Console. Assignment can be done by using the menu command 
"Setup management" in the "Options" menu.
Following tabs can be found in the "Setup management" dialog:
• "Setups" tab
• "Setup packages" tab

Menus and dialog boxes
6.4 "Options" menu

SIMATIC Management Console (V9.1 SP1)
Operating Manual, 09/2021, A5E50318373-AB 145



"Setups" tab
The storage location of a software package must be entered in the "Setups" list if it is to be 
installed with the Management Console. 

Note
Providing the software
• Possible storage location for supplied software:

– Directories and drives
– On the local computers or on the network 

• The software to be installed is available from one shared storage location (shared network 
path, for example \\<Computer name>\<Shared name>).

• The user of the Management Console must have access to the local drives, external drives or 
folders. For more information refer "Managing rights (Page 25)".

• Software distributed between more than one media (for example, 2 DVDs) must be copied 
to the same storage location. This ensures that the media does not need to be changed 
during software installation.

• Only members of the "SIMATIC Management Administrator" user group can install or update 
SIMATIC Management Software. 

• User must be a member of "SIMATIC Management User" group to create packages.

Name Path
Plant-specific setup name Location of the software for SIMATIC product (\\<Compute name>

\<Share name>\<Name of setup file>)

Note
Setups that are not integrated in PCS 7 Setup 
These software packages (WinCC Update, for example) can only be installed using the 
Management Console, if the following requirements are met:
• No input is required in the Setup dialogs during the execution of the setup.
• A setup package has been created for the products. 

"Setup packages" tab

Note
Make sure that only the administrator and no other users have write permission for the directory 
in which the setup files and setup packages for SIMATIC Management Console is located. 

Create plant-specific setups for computers in the "Setup packages" tab. For installation on 
individual computers or groups of computers, select only the required setup packages.
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Managing setup
1. Select the menu command Options > Setup management ... .

The "Setup management" dialog opens.
2. Select the "Setups" tab.

The "Setups" list appears in the "Setup management" dialog.
The following actions are possible:

Action Button Function
Add setup Add Enter the plant-specific name for the software package in 

the dialog. Add the network path (in UNC notation) and 
the name of a setup file.
• "..." button: Select the setup file in the subsequent 

dialog.
• "OK" button: Entry is added.
• "Cancel" button: No new entry.

Remove setup Remove 1. Select an entry in the table.
2. Click "Remove".

The "Confirm removal" dialog opens.
3. Confirm by clicking "Yes".
The software packages are removed from the list. 

Note
Select only one setup to create a setup package. The SIMATIC Management Console does not 
allow selection of multiple setups.

3. Click "OK" to close the dialog.

Note
Confirming license terms and safety instructions
Individuals who confirm the licensing conditions and safety instructions when creating setup 
packages must pay attention to the following:
Ensure that all persons authorized to install the setup packages accept these conditions. 
Recommendation:
If necessary, copy the contents into a file and provide the authorized persons with these 
contents.

Additional information
Section "Setup packages (Page 83)"
Section "Project inventory data export" (Page 148)
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6.4.5 Project inventory data export...

Introduction
This section briefs how the project inventory data export feature can be used for SIMATIC 
Management console. The SIMATIC Management Console can generate data of objects in the 
generic iBase format. iBase is a hierarchical representation of hardware and software data for 
projects. In the iBase format the data is classified into operator systems, automation systems, 
network systems and field components. The classification, reference ID and key number for each 
object can be viewed in the iBase format. This feature helps to export project data in an XML file.

Prerequisites
The following operations must be performed before exporting the inventory data. Please refer 
to the following sections:
1. "Add plant" overview (Page 104)
2. Dialog window "Add plant (1/2)- Specify Engineering Station" (Page 105)
3. Dialog box "Add plant (2/2) – Select projects" (Page 105)
4. Determining inventory data in the plant view (Page 106)

Note
• Project data can be exported for only one project at a time.

Procedure
1. In the "SIMATIC Management Console" window, select "Options>Project inventory data 

export". The "Select project" window appears.
2. In the "Select project" window, select the project to export data in XML format. The "Export 

inventory data" window appears.
3. In the "Export inventory data" window, select the cover page for the project from the "Please 

select the cover page" drop down list. Select the storage location for the XML file from the 
"Please select the storage location" file browser and click "OK".

4. An example of the iBase data in the XML file structure is shown below:

6.4.6 External components...
Use this function to get the external components in the project that cannot be directly read from 
any system component in the inventory data. The external components are displayed in the GUI 
and the inventory report.
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Procedure
1. Select the Options > External components... menu command. 

The "External components" dialog box opens.
2. In the "Please chose the file to import" area, click the [...] button to import the file.
3. Click 'OK'.

The CSV file is imported. The properties of Manual Components.csv file are:
• The timestamp of the imported file is displayed in the "Imported on:" and "Modified on:" fields.
• The user-defined import file must be in CSV format. 
• The first line must contain names of the header (seperated with ";").  
• The lines containing devices with their special information (seperated with ";"). 
• The "External components" tab contains the same content in all languages. Translation is not 

needed here.
Example for customer components CSV file is as follows:
Name of device; Tech location; Serial Number; Version; Description 
HP Printer 460; Test area 5; 100-55-768;V6.1; Printer for Logging 
Test Switch; Test area 6; 54XC-FDE;V6.2; Switch for special test

Note
Check the "Delete External Components" option to delete the imported file, else, the newly 
imported file will replace the existing one.

6.4.7 Inventory data profile wizard...
The Management Console allows the user to compare ACTUAL device configurations with saved 
device configurations. 
As a filter for the comparison, apply inventory data profiles that are created with the inventory 
data profile wizard.

Requirements
• Inventory data have been determined in the Management Console. 
• The currently determined inventory data contains the corresponding categories.
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Note
Examples of missing categories in the inventory data
• The current inventory data only contains the installed license keys:

An inventory data profile for determining "Installed SIMATIC software" cannot be created. 
• Inventory data profiles are always view-specific (network view or plant view).

If the current inventory data has only been determined in the network view, inventory data 
profiles cannot be created for the plant view.

• If needed, determine the inventory data in the network or plant view before creating a new 
inventory data profile.

Actions with the inventory data profile wizard 
The following actions are possible with the inventory data profile wizard:

Actions Dialog
Select origin of inventory data and action Section "Dialog "Inventory data profile wizard (1/3) - Select 

view and action" (Page 114)"
Specify parameter sets Section "Dialog "Inventory data profile wizard (2/3) - Create/

change inventory data profile" (Page 115)"
Select version categories and save/export 
the inventory data profile

Section "Dialog box "Inventory data profile wizard (3/3) - 
Save inventory data profile" (Page 119)"

6.4.8 Create license report...
Use this function to forward the plant-specific license report to a Siemens contact person.

Requirement
The engineering station has been specified.
For more information refer "Settings... (Page 140)".

Procedure
1. Select the Options > Create license report... menu command.

The "Create license report - use of license keys" dialog box opens.
2. Select a cover page from the drop-down list box for the license report.
3. Select a storage location for the license report.
4. Click "OK". 

Result
The result is stored in an XLSX file.
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6.5 "?" menu (Help menu)

6.5.1 Available plug-ins...
The command "Available plug-ins..." is used to display information about the Management 
Console components (plug-ins). 

Requirements
The user of the Management Console is a member of the "SIMATIC Management User" Windows 
group.

Procedure
1. Select the menu command ? > Available plug-ins ... .

A list with the following columns is displayed in the dialog box:

Column Meaning
Plug-in name Name of the Management Console component
Company Component manufacturer
Version Version number of the component
Description Area of application in the Management Console

6.5.2 Help
This menu command is used to open the "SIMATIC Management Console" help files in the PUD 
application.

6.5.3 Info...
Legal information is displayed.
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